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About this Publication

This publication explains how to print and finish booklets and documents with the IBM InfoPrint 60 finisher.
It describes how the InfoPrint 60 printer and finisher work together under system control to let you produce
booklets and documents using these IBM software products:

v InfoPrint Manager

v AS/400

v PSF/MVS

v Page Printer Formatting Aid (PPFA)

This publication is updated on the Internet. For the latest copy, select:
http://www.printers.ibm.com --> Tech Support --> Manuals
or
http://www.printers.ibm.com/manuals.html

Who Should Use this Publication?

This publication is for users who want to print and finish booklets and documents with the IBM InfoPrint 60
finisher.

Examples of the tasks the finisher can do are:

v Edge-stitching

v Corner-stapling

v Folding and saddle-stitching

v Inserting pre-printed tabs

v Inserting z-folded pages

This publication assumes you are familiar with the IBM software products listed above and with the IBM
InfoPrint 60 printer.

Using this Publication
1. Read and follow the directions in:

v “Chapter 1. InfoPrint 60 Finisher Introduction” on page 1

This chapter explains the types of operations you can perform with the finisher. It also explains how
to orient paper in the printer and finisher.

2. Read and follow the directions in one of these chapters, according to the IBM software product you
are using:

v “Chapter 2. Printing with InfoPrint Manager” on page 13

v “Chapter 3. Printing with PSF/MVS” on page 49

v “Chapter 4. Printing with AS/400” on page 53

3. If necessary, read and follow the directions in:

v “Chapter 5. Form Definition and PPFA” on page 75

Explains how to use the Page Printer Formatting Aid (PPFA) to define media, logical page
orientation, bins, finishing instructions, and types of presentations

v “Appendix. Paper Path” on page 105
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The sheet position in an input tray, the sheet size, simplex or duplex operation, input tray selection,
and finisher selection determines how the media moves through the printer and finisher. The
following sections describe the paper path and sheet orientation during printing and finishing.

Related Publications

These publications contain additional information about the IBM InfoPrint 60 and related products:

Advanced Function Presentation (AFP)
v Guide to Advanced Function Presentation, G544-3876

v Advanced Function Presentation: Printer Information, G544-3290

v Advanced Function Presentation: Printer Summary, G544-3135

v Mixed Object Document Content Architecture Reference, SC31-6802

v Advanced Function Presentation: Programming Guide and Line Data Reference, S544-3884

InfoPrint Manager for AIX

InfoPrint provides the following publications in PDF format on a CD-ROM supplied with the product:

v IBM InfoPrint Manager for AIX: Administrator’s Guide, S544-5595

v IBM InfoPrint Manager for AIX: User’s and Planning Information, S544-5604

v IBM InfoPrint Manager for AIX: User’s and Operator’s Guide, S544-5596

v IBM InfoPrint Manager for AIX: Reference Guide, S544-5475

v IBM InfoPrint Manager for AIX: Administrator’s Guide, S544-5595

Print Services Facility (PSF) for AIX
v IBM Print Services Facility for AIX: AIX for Users of Print Services Facility, S544-3877

v IBM Print Services Facility for AIX: Print Administration, S544-3817

v IBM Print Services Facility for AIX: Print Submission, S544-3878

v IBM Print Services Facility for AIX: Advanced Function Presentation Conversion and Indexing Facility,
S544-3930

v Conversion and Indexing Facility, S544-3930

AS/400
v AS/400 Guide to AFP and PSF, S544-5319

v AS/400 Printer Device Programming, SC41-3713

v IBM AS/400 Printing IV, GG24-4389

v DDS Reference, SC41-5712

Advanced Function Printing PrintSuite for AS/400
v AS/400 Advanced Utility User’s Guide, S544-5351

v IBM Advanced Function Presentation: Toolbox for AS/400 User’s Guide, S544-5368

PSF/VSE, PSF/MVS, and PSF/VM
v VSE: Application Programming Guide, S544-3666

v VSE: System Programming Guide, S544-3665

v Print Services Facility/MVS: Application Programming Guide, S544-3673

v Print Services Facility/MVS System Programming Guide, S544-3672
xiv InfoPrint 60 Finisher Application Design Guide



v JES2 Initialization and Tuning Reference, SC23-0083

v PSF/MVS System Programming Guide, S544-3672

v PSF/MVS Application Programming Guide, S544-3673

Applications
v IBM Page Printer Formatting Aid: User’s Guide, S544-5284

InfoPrint 60 and Finisher
v InfoPrint 60 Finisher User and Planning Information, S544-5604

v InfoPrint 60 User’s Guide, S544-5432

v 3160 and InfoPrint 60 Installation and Planning Guide, G544-5242

v Advanced Function Presentation: Printer Information, G544-3290
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Chapter 1. InfoPrint 60 Finisher Introduction

This chapter explains the types of operations you can perform with the finisher. It also explains how to
orient paper in the printer and finisher.

Be sure you have read InfoPrint 60 Finisher: User and Planning Information, S544-5604, before you use
this document.

The sheet position in an input tray, the sheet size, simplex or duplex operation, input tray selection, and
finisher selection determines how the media moves through the printer and finisher (see “Appendix. Paper
Path” on page 105).

Types of Finishes

Using the IBM InfoPrint 60 finisher and IBM software, you can produce booklets and documents with these
types of finishes:

v Unfolded single sheets

v Unstapled single sheets

v Unfolded, edge-stitched (2 or 3 staples) or corner-stapled sheets

v Folded, saddle-stitched sets (booklets)

v Ledger or A3 z-folded sheets included in stapled documents

v Stapled or unstapled sets that include items (such as pre-printed tabs) fed from the finisher insert tray

v Saddle-stitched documents with sheets from the printer and the insert tray

Terms

These terms describe finisher operations:

Term Definition

Corner Staple One staple inserted in one corner of a document by the stapler.

Default A value, attribute, or option that is assumed when none has been specified.
Default implies a factory setting that can be changed after your printer or
finisher is installed.

Edge Stitch Two or three staples inserted along one edge of a document by the stapler.

Insert A sheet that is included in a finisher job and that is fed from the insert tray,
not the printer. Note : You cannot print on an insert.

Long-Edge Feed
(LEF)

The long edge of the paper is the leading edge as it travels through the
paper path.

Saddle Stitch Two staples inserted in the centerfold of a set of sheets by the saddle
stitcher.

Short-Edge Feed
(SEF)

The short edge of the paper is the leading edge as it travels through the
paper path.

Z-Fold Ledger-size paper is folded up at 8.5 inch from the left edge, and folded up
at an additional 4 inch. to fit in an 8.5 x 11 sheet set. The remaining length
rests on top. A3-size paper is folded into A4.

© Copyright IBM Corp. 1998 1



Default Operations

Figure 1 shows the possible operation that can be performed using the finisher.

The defaults for the finisher are:

Process Default

Corner Staple Top Left for short-edge feed, long-edge feed paper.

Edge Stitch Left Edge for long-edge feed paper. Top Edge for short-edge
feed paper. The default number of staples is 2.

Saddle Stitch Top Edge. The default number of staples is 2.

Z-fold Top Edge

Figure 1. Finisher Operations
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IBM Software Products

The types of finishing operations you can use depend on the IBM software product you use:

Table 1. Finishes for IBM Software Products

Process Function InfoPrint
Manager

PSF/MVS PSF/400 PSF/VM PSF/VSE

Stapler Corner staple Yes Yes Yes No No

2 staple edge
stitch

Yes Yes Yes No No

3 staple edge
stitch

Yes Yes Yes No No

Stack Offset or Straight
Stacking

Yes Yes Yes Yes Yes

Saddle Stitch Yes Yes Yes No No

Z-Fold Staple Yes Yes Yes No No

No staple Yes Yes Yes No No

Insert Covers Yes Yes Yes Yes Yes

Separator Sheets Yes Yes Yes Yes Yes

Pre-printed
sheets

Yes Yes Yes Yes Yes

Your IBM software must be at the correct service level to perform the functions listed in Table 1. See your
IBM representative for more information.

Finisher Overview

The finisher handles each sheet as it arrives from the printer and can interleave sheets fed from the insert
tray. The stapler can only insert staples in the leading edge of the document as it passes through the
finisher. You can include some z-folded forms in a document (see the InfoPrint 60 Finisher User and
Planning Information, S544-5604). The saddle-stitcher inserts staples at the center of a set of sheets and
folds them.

Finisher Trays

Figure 2 on page 4 shows the names and locations of the finisher trays.
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Finisher Capabilities

Table 2 shows the finisher capabilities.

Table 2. InfoPrint 60 Finisher Capabilities

Paper
Size

Insert
Tray

Z-Fold Saddle
Stitch

Corner Staple Edge Stitch

Top
Left

Top
Right

Bottom
Left Bottom

Right

Top Bottom Left Right

Letter

LEF

SEF*

Y

Y

N

N

N

Y

Y

Y

Y

Y

Y

Y

Y

Y

N

Y

N

Y

Y

N

Y

N

A4

LEF

SEF*

Y

Y

N

N

N

Y

Y

Y

Y

Y

Y

Y

Y

Y

N

Y

N

Y

Y

N

Y

N

Ledger

SEF Y Y Y Y Y Y Y Y Y N N

A3

SEF Y Y Y Y Y Y Y Y Y N N

Legal

SEF Y N Y Y Y Y Y Y Y N N

Figure 2. Finisher Trays
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Table 2. InfoPrint 60 Finisher Capabilities (continued)

Paper
Size

Insert
Tray

Z-Fold Saddle
Stitch

Corner Staple Edge Stitch

Top
Left

Top
Right

Bottom
Left Bottom

Right

Top Bottom Left Right

B5

LEF Y N N Y Y Y Y N N Y Y

B4

SEF Y N N Y Y Y Y Y Y N N

LEF - Long Edge Feed

SEF - Short Edge Feed

* Printer runs at 30 pages/minute maximum

Input Capacities

The finisher has these capacities when using 20 lb paper:

v Stapler maximum - 50 sheets per set.

v Saddle stitcher maximum - 15 sheets per set.

v Stapler maximum - 3 z-folded sheets per set. Each z-fold page counts as 7 sheets for stapler finishing
operations. The effective sheet count equals 7 x (number of z-folds) + (number of non-z-fold sheets).

v Insert tray maximum - 250 sheets.

Output Capacities

The finisher has 3 output areas. The finisher has these capacities when using 20 lb paper:

v Stacker tray - maximum of 1600 sheets.

v Exit tray - maximum of 50 sheets; only receives single sheets and incomplete documents if a paper jam
occurs.

v Saddle stitcher drawer - ranges from a maximum of 100 sets with 2 sheets stapled to a maximum of 15
sets with 15 sheets stapled.

Table 3 shows the stacker PSF output bin number and sheet capacity.

Table 3. Stacker Capacity

PSF Output Bin
Number

Stacker Capacity (No. of
Sheets)

1 Base Stacker* 500

3 Side Stacker 1 500

3 Side Stacker 3 000 (option)

3 Finisher Stacker
Tray (Default)

1600

* When the finisher is installed, the finish stacker is the
default.
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Printer Overview

The IBM InfoPrint 60 printer can have up to 4 input trays. The finisher has one insert (input) tray. You can
put different size paper in each tray of the printer and in the finisher’s insert tray. This lets you print using
paper from different trays from the printer and pre-printed sheets from the finisher insert tray.

Note: If you are using different trays from the printer and finisher, make sure that the correct paper sizes
are in the trays before you submit your print job. One way to do this is to submit your job with a
hold attribute to put the job on hold at the server. When you are sure the printer has the correct
paper sizes for each tray you are using, you can release the job to the printer.

Printer Trays

Figure 3 shows the names and locations of the printer input and output trays, and the PSF and PPFA BIN
number.

Table 4 shows the configuration of the input trays.

Table 4. Input Tray Configuration

PSF
Input Bin
Number

Priority
Default

Input Tray Name Capacity (No. of
Sheets)

Paper Size

1 1 Main tray 2 000 A3, A4, B4, B5, ledger, legal, letter

2 4 Lower sub tray 500 A3, A4, B4, B5, ledger, legal, letter

3 3 Upper sub tray 500 A3, A4, B4, B5, ledger, legal, letter

4 2 Side tray (option) 2 000 A4, letter (long-edge feed only)

Side Tray
(Optional)

Bin 4

Main Tray
Bin1

Upper Sub Tray
Bin 3

Output Tray
Bin 3

Output Tray
Bin 1

Lower Sub Tray
Bin 2

Figure 3. IBM InfoPrint 60 Trays

6 InfoPrint 60 Finisher Application Design Guide



Physical Form Sizes

Table 5 shows the physical form sizes for the IBM InfoPrint 60.

Table 5. Printable Physical Form Sizes

Paper Name Paper Size (inch) Paper Size (mm)

letter (L, P, S)* 8.5 x 11 215.9 x 279.4

legal (P, S) 8.5 x 14 215.9 x 355.6

ledger (L, S, Z-fold) 11 x 17 279.4 x 431.8

A3 (P, S, Z-fold) 11.7 x 16.6 297 x 420

A4 (L, P, S)** 8.3 x 11.7 210 x 297

B4 (L - corner staple
only)

10.1 x 14.3 257 x 364

B5 (P - corner staple
only

7.2 x 10.1 182 x 257

Note: Use the Paper Sizes shown in bold in any reference to print
media sizes. The non-highlighted sizes are provided only for
comparison.
Note: P - long-edge feed, L - short-edge feed, S - saddle stitch
(always long-edge feed).

* A custom form definition is required when using 8.5 x 11 with
short-edge feed.

** A custom form definition is required for A4 short-edge feed.
Variable size paper side guide feature is required and may only be
used in lower and upper sub trays of the printer.

Figure 4 shows the European stock sizes, which are based on paper size A0. A0 is 1 square meter. Each
time the form is cut in half, it produces another sizes (A1, A2, A3, A4, A5, and A6).

Table 6 shows the dimensions for Figure 4.

Table 6. European Stock Sizes

Size MM (approx.) Inch (approx.)

A0 841 x 1,189 33.13 x 46.75

A1 594 x 841 23.38 x 33.13

A2 420 x 594 16.5 x 23.38

A1

A2

C
2P

I0
02

1

A0 = 1 square meter

A3

A4

A5
A6

A6

A0

Figure 4. European Stock Sizes
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Table 6. European Stock Sizes (continued)

Size MM (approx.) Inch (approx.)

A3 297 x 420 11.75 x 16.5

A4 210 x 297 8.25 x 11.75

A5 148 x 210 5.95 x 8.25

A6 104 x 149 4.2 x 6

Figure 5 shows United States standards, which are based on the 8.5 x 11 inch paper (A-size). Each larger
size doubles the short side (8.5 x 11 becomes 17 x 11).

Table 7 shows the dimensions of Figure 5.

Table 7. United States Stock Size Dimensions

Size MM (approx.) Inch (approx.) Name

A 215.9 x 279.4 8.5 x 11 A size Letter

B 279.4 x 431.8 11 x 17 B size Ledger

C 558.8 x 431.8 22 x 17 C size

D 558.8 x 863.6 22 x 34 D size

E 1117.6 x 863.6 44 x 34 E size

Sheet Orientation

Sheet orientation in a bin or side tray is important when using pre-printed sheets or three-hole punched
sheets or both. When finishing, consider these points:

1. The size of the sheet.

2. The sheet orientation if pre-printed or three-hole punched or both.

3. The bin location.

4. You can select these items through the FORMDEF or the graphical user interface (GUI), depending on
the IBM software product you are using:

v The type of finishing: saddle-stitch, corner staple, two-staple edge stitch, or three-staple edge stitch

v Sheet insertion from the insert tray into the document

5. The orientation of page data on the sheet. The finisher can only staple on the leading edge of the
paper; therefore, the printer automatically rotates page data when stapling is requested on one of the
other edges or corners.

D

C

C
2P

I0
02

2

E = Size

B

A

A

Figure 5. United States Stock Sizes
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6. If you use a header and/or trailer with a saddle-stitch application, the header/trailer output goes to the
output bin and the job goes to the saddle bin.

For Stapling

Sheet placement in a tray depends on whether or not you are using pre-printed sheets or pre-punched
sheets for simplex or duplex operations.

The printer operator can set the side-sensitive or edge-sensitive settings and place the paper in the input
trays. Figure 6 through Figure 9 on page 10 show this relationship. The top-left corner staple is indicated
by Í.

Note: Side-sensitive and edge-sensitive settings are defined in the InfoPrint 60 User’s Guide, S544-5432.

Side Sensitive  NOSimplex Edge Sensitive N/A
Printer

Input Tray
Orientation

Finisher
Input Tray
Orientation

Top TopFeed Feed Top

Face
Down

Face
Up

Face
Down

Face
Down

Face
Up

Face
Down

T
o
p

T
o
p

T
o
p

Finisher
Output

Orientation

C
2P

I0
04

6

Figure 6. Edge Stitch, Simplex

Side Sensitive  YES

Side Sensitive  NO

Simplex

Duplex

Edge Sensitive N/A

Edge Sensitive N/A

Printer
Input Tray
Orientation

Finisher
Input Tray
Orientation

Top TopFeed Feed Top

Face
Up

Face
Up

Face
Down

Face
Up

Face
Up

Face
Down

T
o
p

T
o
p

T
o
p

Finisher
Output

Orientation

C
2P

I0
04

7

Figure 7. Edge Stitch, Duplex
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For Saddle Stitching

Sheet placement in a tray depends on whether or not you are using pre-printed sheets or pre-punched
sheets for simplex or duplex operations.

Figure 10 through Figure 12 on page 11 show the side-sensitive or edge-sensitive settings on the printer
and paper placement in the input trays.

Feed Feed Top

Face
Down

Top Top

Face
Up

Face
Up

C
2P

I0
04

8

Side Sensitive  NOSimplexSide Tray Edge Sensitive N/A

Printer
Input Tray
Orientation

Finisher
Input Tray
Orientation

Finisher
Output

Orientation

Figure 8. Edge Stitch Side Tray, Simplex

Feed Feed Top

Face
Down

Top Top

Face
Down

Face
Up

C
2P

I0
04

9

Side Sensitive  YES
Side Sensitive  NO

Simplex
Duplex

Side Tray
Side Tray

Edge Sensitive N/A
Edge Sensitive N/A

Printer
Input Tray
Orientation

Finisher
Input Tray
Orientation

Finisher
Output

Orientation

Figure 9. Edge Stitch Side Tray, Duplex

Printer
Input Tray

Orientation

Finisher
Input Tray
Orientation

Finisher
Output

Orientation

Top TopTop Top Top

Front
Cover

Front
Cover

Back
Cover

C
2P

I0
05

1

Side Sensitive  NODuplex Edge Sensitive NO

Feed Feed

Figure 10. Saddle Stitch 1
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The examples in Figure 11 and Figure 12 use a cover sheet pulled from the finisher insert tray. They show
how the paper must be oriented in the InfoPrint 60 input tray and finisher insert trays for the output print
job.

Printer
Input Tray

Orientation

Finisher
Input Tray
Orientation

Finisher
Output

Orientation

Top TopTop Top

Top

Front
Cover Front

CoverBack
Cover

C
2P

I0
05

2

Side Sensitive  N/ADuplex Edge Sensitive YES

Feed Feed

Figure 11. Saddle Stitch 2

TopTop Top

T
o
p

Top

Front
C

over

Front
Cover

B
ack

C
over

C
2P

I0
05

3

Printer
Input Tray

Orientation

Finisher
Input Tray
Orientation

Finisher
Output

Orientation

Side Sensitive  NODuplex Edge Sensitive NO

FeedFeed

Figure 12. Saddle Stitch 3 (Calendar Type)
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Chapter 2. Printing with InfoPrint Manager

This chapter explains how to print and finish booklets and documents with the IBM InfoPrint 60 finisher
and InfoPrint Manager.

Be sure you have read “Chapter 1. InfoPrint 60 Finisher Introduction” on page 1 before you use this
chapter.

Figure 13 shows the InfoPrint Manager system. The main point of control for the print shop is the
customer’s Windows PC or Macintosh workstation with the InfoPrint application software called InfoPrint
Submit. Using InfoPrint Submit, users can send print jobs to an AIX workstation, called the Multiple Printer
Controller (MPC) server. The MPC server lets you control print jobs and printers.

Setting Up the Server

After the IBM InfoPrint 60 finisher is connected to the server, you need to set up the server:

v Define the InfoPrint 60 finisher to InfoPrint Manager using the InfoPrint_60_Finisher template icon (see
“Defining the InfoPrint 60_Finisher”).

v Define the media (for example: legal, A4) for the InfoPrint 60 finisher (see “Defining the Media” on
page 15).

Defining the InfoPrint 60_Finisher

To define the InfoPrint 60 finisher to InfoPrint Manager:

1. In the Common Desktop Environment, select the arrow above the InfoPrint Manager icon.

2. From the pop-up menu, select Print Administration . After a period of time you see the InfoPrint
Administration window (Figure 14 on page 14).

Figure 13. System Configuration
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3. From the bottom of the window, select Preferences «7¬.

v You see the User Preferences window. Scroll to the bottom of the window and set Allow display
of Documents to yes and Display Medium untrimmed width and length in to inch or
millimeters.

v Select OK. You see the InfoPrint Administration window again.

4. Click on the Template Area icon «1¬ .

5. Use the slide-bar in Actual Destination Templates «2¬ to find the InfoPrint_60_Finisher template
icon.

6. Select (use the middle mouse button on a 3 button mouse or both buttons on a 2 button mouse)
InfoPrint_60_Finisher and drag-and-drop it into Actual Destinations «5¬ . You see the Add PSF
Physical Printer window (Figure 15 on page 15).

Figure 14. InfoPrint Administration Window
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7. Enter the physical printer name, TCP/IP Internet address, TCP/IP port number, and other areas as
required.

8. Select OK. You see the InfoPrint Administration window again.

9. Icons in the Logical «4¬ and Actual Destinations «5¬ areas show the physical printer name.

10. Select the yellow light bulb «3¬ and drag-and-drop it into the Logical «4¬ and Actual Destinations
«5¬ icons to enable the new printer.

Defining the Media

You must specify the type of media in each input tray. To define the media for the finisher:

1. In the Other Objects «6¬ in the InfoPrint Administration window, right-click on the Media icon and
select Add... . Enter the media name and autotrimmed size. For example: in media name, enter
rotletter and in autotrimmed size, enter 8.5 x 11. When the media name (rotletter) is selected, 8.5 x 11
sheets can be saddle stitched to create 8.5 x 5.5 booklets.

Note: You must also define a custom form (rotletter) on the printer to match. In addition, you must
generate a media icon for each paper type used in the printer’s input trays; for example: insert1.
This lets users select the insert tray and specify the paper to be placed in the finisher input tray.

2. Select OK.

3. Double-click the Media icon.

4. Scroll through the icons and select the new media icon you just created. Drag-and-drop it into the
InfoPrint 60 finisher icon that you created in Actual Destinations «5¬ (see step 10).

5. Create additional Media icons for each paper type that is to be used for the InfoPrint 60 finisher.

6. In Actual Destinations «5¬, double-click the InfoPrint 60 finisher icon you created. You see the Note
Book window (Figure 16 on page 16).

C
2P

I0
02

4

Figure 15. Add PSF Physical Printer Window
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7. From the Summary drop-down menu «1¬, select Media . You see the Media window (Figure 17 on
page 17 ).
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I0
02

5

Figure 16. View and Change PSF Physical Printer Properties Window
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8. In Media ready «1¬, select Add.. . You see Add Value Window (Figure 18 on page 18).

Note: Figure 3 on page 6 shows the trays and bin numbers for the InfoPrint 60. Figure 2 on page 4
shows the trays and bin numbers of the finisher. The insert tray for the finisher is called insert
with a bin number of 7. In addition, you can alter the ″Output bin numbers″ «2¬, ″Input trays
supported″ «3¬, and ″Output bins supported″ «4¬.
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Figure 17. Media Window
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9. For each input tray on the printer, do these steps:

v In ″*Input tray″, enter the tray name (example: main).

v In ″*Medium ready″, enter the paper size (example: letter).

v In ″Input bin number″, enter the bin number (example: 1).

Submitting Print Jobs

After you set up the server, you can submit print jobs to the finisher using on of these ways:

v Command line using pdpr on the MPC, “Using the Server (MPC) Command Line”

v InfoPrint Submit on the PC or Macintosh workstation, “Using InfoPrint Submit” on page 19

v Select from an application on the PC or Macintosh workstation, “Using Select” on page 24

Using the Server (MPC) Command Line

You can use the pdpr command to submit print jobs to the printer finisher. The man pdpr command (the
man command is like a help command) explains how to use the command.

Figure 19 on page 19 shows pdpr commands that you can use with the finisher:
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Figure 18. Add Value Window

18 InfoPrint 60 Finisher Application Design Guide



Using InfoPrint Submit

You must define the InfoPrint 60 finisher to the server (see “Setting Up the Server” on page 13) before you
can specify finishing options with InfoPrint Submit from the PC or Macintosh workstation. You can send
print jobs and specify finishing options, or you can use form definitions. However, you can use the ″insert
sheet″ item without having a finisher defined because an insert sheet can come from an InfoPrint 60 or
finisher input bins.

Overview

The finishing options in InfoPrint Submit are:

v Edge stitch

v Saddle stitch

v Z-Fold

v Inserts (from InfoPrint 60 or finisher)

*********************************************************************************************
************** Condition for the following print examples **************
************** Printers names are finish (InfoPrint 60 finisher **************
************** and (nofinish any printer) motd.ps is a PS file **************
************** Line continuation character "\" *************

-pdpr -p lp -x "physical-printer-requested=finish" motd.ps
-pdpr -p lp -x "physical-printer-requested=finish job-finishing=staple-top-left" motd.ps

-pdpr -p lp -x "physical-printer-requested=finish job-finishing=staple-bottom-left" motd.ps

-pdpr -p lp -x "physical-printer-requested=finish job-finishing=edge-stitch-2" motd.ps

-pdpr -p lp -x "physical-printer-requested=finish job-finishing=edge-stitch-3" motd.ps

*********** printer set up, tray 1 - letter, tray 2 - ledger, insert tray 7 finisher ***********

-pdpr -p lp -x physical-printer-requested=finish \
-x default-medium=ledger \
-x job-finishing=saddle-stitch motd.ps

*********** Insert a sheet between two printed sheets all 8.5 x 11 ***********

-pdpr -p lp -x physical-printer-requested=finish \
-x default-medium=letter motd.ps \
-x default-medium=insert motd.ps \
-x default-medium=letter motd.ps

*********** Z-fold job, with the first sheet 8.5 x 11, second two ledger ***********
*********** z-folded, and last sheet ledger not z-folded.***********

-pdpr -p lp -x physical-printer-requested=finish \
-x default-medium=letter motd.ps\
-x default-medium=ledger -x document-finishing=z-fold file.tif file.tif \
-x default-medium=ledger -x document-finishing== motd.ps

*********** Booklet (Saddle Stitch) ***********

-pdpr -p lp -x job-finishing=saddle-stitch \
-x sides=2 -x plex=simplex -x output-format=booklet-print -x n-up=2 -x default-medium=ledger \
file.ps motd.ps file.ps

Figure 19. Command Line Examples
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The print job flow from Submit is:

1. Submit build ticket (PC user):

v Send job to server.

v The server RIPs the print job.

v If print jobs do not use the defaults PPR types and bins, the job ticket should specify hold . One way
to do this is to send the jobs as ″use server default″, and set up the default to RIP and hold for all
InfoPrint 60 finisher jobs.

2. For each held job, you should:

a. Determine job needs:

v Media (use pdls -U -rall servername:jobid grep medium )

v Pre-printed or blank inserts (the same pdls will list whatever media name is used for inserts).
You must know which input tray corresponds to the requested media.

b. Load sheets into the printer or the finisher input trays or both.

c. Adjust the finisher as needed (for example: z-fold, saddle stitch).

d. Modify the physical printer media to be ready for media and inserts.

e. Release the job to the InfoPrint 60 finisher.

Procedure

InfoPrint Submit is represented by an icon displayed on your PC or Macintosh desktop. This procedure
shows the process of developing a document that has multiple PostScript (PS) files, using different trays in
the printer, and using select sheets from the finisher’s input tray:

1. Double-click the InfoPrint Submit icon to launch InfoPrint Submit. You see the InfoPrint Submit Job
Ticket window (Figure 20 on page 21).
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2. Select the Document «1¬ and select the Layout tab. The Layout tab shows the default values for all
files listed under the Document. You can select each file listed under the Document to define specific
finisher options (for example: z-fold, staple). When you select the PS file or Sheet 1 (insert), some
areas of the tabs may not be active.

3. Select Options → Preferences to set up printer, layout, and to schedule defaults.

Note: The tray function might vary for different jobs, so IBM recommends that you do not set the tray
information.

4. Select Ticket → New to make the defaults apply to the current job ticket.

5. When you have selected options in the Layout and Sides fields on the Layout tab, the document «2¬
displays the page layout. The n indicates the last page of the file.

Note: You can associate a document with a form definition by using the ″Use form definition″ (see
“Sample Form Definitions” on page 85). However, a document using the form definition ignores
all definitions in InfoPrint Manager and causes the document to print as it would if submitted
by PSF/MVS or AS/400. Therefore, you are responsible for ensuring the correctness of the
finishing requests in the form definition.

6. Select the Print tab. You see the InfoPrint Submit Job Ticket window with the Print tab highlighted
(Figure 21 on page 22).

Figure 20. InfoPrint Submit Job Ticket Window - Layout Tab
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7. For Printer type , select ″Any black and white printer″ or ″InfoPrint 60″. Select other options as
necessary.

8. Select the Align tab. You see the InfoPrint Submit Job Ticket window with the Align tab highlighted
(Figure 22 on page 23).
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Figure 21. InfoPrint Submit Job Ticket Window - Print Tab
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9. Select the appropriate page size options.

10. Select Look tab. You see the InfoPrint Submit Job Ticket window with the Look tab highlighted
(Figure 23 on page 24).
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Figure 22. InfoPrint Submit Job Ticket Window - Align Tab
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11. For RIP for select, ″InfoPrint 60″.

12. If you select Screen frequency , remember that a smaller screen frequency (71 lines per inch) has a
greater number of shades of gray [(300 lpi ÷ 71 lpi)E(2) = 19]. A larger screen frequency (141 lpi) has
a smaller number of shades of gray [(300 dpi ÷ 141 lpi)E(2) = 5].

Using Select

You use the InfoPrint Port to set up printing from a word processing application, such as Wordpad. You
add a printer before you can print.

Adding a Printer
1. From Windows 95, select Start → Settings → Printers . Follow the instructions in the Select Readme file

to add a new printer.

2. From the list of IBM printers shipped with InfoPrint Port, select IBM InfoPrint 60 with Finishing .

3. You see a new icon in the Printers window.

4. Select the new icon and select File → Properties .

5. Configure your port settings as described in the Select Readme file. Be sure you select the logical
printer that represents an IBM InfoPrint 60 finisher.

Printing from an Application

To send your print job to the InfoPrint 60 finisher from an application (for example, Wordpad):

1. Select the application’s print dialog.

2. Select the printer you added above. The default name is ″IBM InfoPrint 60 with Finishing″.
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Figure 23. InfoPrint Submit Job Ticket Window - Look Tab
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3. Select printer properties (this varies from application to application).

4. Select the paper size and other print options that you want.

5. Select the Device Options tab. The Printer features for the InfoPrint 60 finisher are listed. The IBM
InfoPrint 60 finisher options are:

v Z-fold: Select Yes to have all pages in your file z-folded (maximum of 3 z-folded pages).

v Staple Options: Select the type of stapling you want, or select None.

6. Select the device options as required.

7. Select OK.

8. Print your file from the application’s print dialog.

The default job for the InfoPrint 60 finisher should specify ″RIP and Hold″ or ″Hold″. Only one file is sent
with Select, so you can easily tell which media is required. When the job is on the print queue, you must
check the job for the media required and finishing options and adjust the printer and finisher as required
(see “Operator Tasks”).

Operator Tasks

The print jobs that the user submits might require one or more bins, and each bin might have a different
sheet size and require finisher setup. If the job requires different paper than the paper that is currently
loaded in the printer and requires a different setup for the finisher, the job should be sent with the Hold
option (see step 20).

You, as the operator, need to set up the printer and finisher for the jobs that require different paper sizes
and finishing requirements. The user might have set the bin numbers, which does not apply to the
InfoPrint 60 finisher operation.

If the print job is not placed on hold and the finisher and printer are not set up correctly, the print job
terminates. You can release the job to print and finish on the InfoPrint 60 finisher after the input paper
trays are loaded and the finisher is set up.

Determining Media and Finisher Requirements

To determine the media and finisher requirements to see if the job requires your attention:

1. From the bottom of the InfoPrint Management window (Figure 24 on page 26) select ″Preferences″ (the
button at the bottom-left of the window).

v You see the User Preferences window. Scroll to the bottom of the window and set Allow display of
documents select to Yes.

v Select OK. You see the InfoPrint Management window again.

2. Click on the InfoPrint 60 finisher printer «1¬ → Open window action «2¬.
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3. You see the Destination Queue window (Figure 25 on page 27).

4. Look in the Medium column for see documents «3¬. You can use the slide-bar to see all the jobs.
Write down the job’s ID for each print job that has see documents in the Medium column.

v To see the Grid View displayed, select «1¬

v To see the Details View displayed, select the small boxes to the right of «1¬ (current display for
Figure 25 on page 27)

v To use Grid View or Details View, select either one and drag-and-drop onto the display of jobs
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Figure 24. InfoPrint Management Window
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5. Determine the media and finisher requirements for each print job by using either:

v The GUI “Using the GUI”

v The command line “Using the Command Line” on page 32

Using the GUI

This section explains how to determine the media and finisher requirements for the print job using the
InfoPrint Management graphical user interface (GUI).

Media Determination

To determine the media requirements of the printer for the print job you selected:

1. From the Destination Queue window (Figure 25), drag-and-drop the View Controls «1¬ into the Jobs
area «3¬. As you drag-and-drop into the Jobs area, you see the insert arrow at the bottom of the
Jobs area «2¬.

2. Highlight your job and press F8. You see the Destination Queue window 2 (Figure 26 on page 28).
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Figure 25. Destination Queue, Window 1
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3. Double-click on the job «1¬ that was marked see documents in the Medium column «3¬ in Figure 25
on page 27. (To view the previous window, press F9.)

4. You see the Destination Queue window 3 (Figure 27 on page 29). You might need to use the scroll
bars to find the job and the files contained in the job («3¬, «4¬, «5¬, and «6¬).
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Figure 26. Destination Queue Window 2
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5. Double-click on the first file in the job «3¬. You see the View and Change Document Properties
window (Figure 28 on page 30).
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Figure 27. Destination Queue Window 3
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6. From the Summary drop-down menu «1¬, select Processing . You see the View and Change
Document Properties window 2 (Figure 29 on page 31).
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Figure 28. View and Change Document Properties Window 1
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7. Select the appropriate fields to set up the processing options for the printer. Load the printer bins with
the paper requirements for the job as defined in the Medium requested and Input tray requested
areas.

8. Select OK.

9. Repeat these steps for each file in the job and select the appropriate processing options.

10. Check the printer and finisher to be sure they have:

v A3 or 11x17, z-fold stop setting, if applicable

v Saddle, Booklet setting (two settings), if applicable

v Correct sheet size in each bin

11. Double-click the job «2¬ in the Destination Queue window 3 (Figure 27 on page 29).

12. Select the job «2¬ in the Destination Queue window 3 (Figure 27 on page 29) and then select the
yellow light bulb «1¬ to release the job to the InfoPrint 60 finisher.

Finisher Requirements

Finishing requirements are listed in the ″View and Change Document Properties window 2″ (Figure 29)
under ″Finishing options″. For more information see Destination Queue Window 1 (Figure 25 on page 27).

1. Drag-and-drop the Details View (Figure 26 on page 28) on the Jobs ID screen.

2. Doube-click the job.

3. Select Summary → Scheduling.

4. Scroll down to Finishing Options to determine the finishing requirements.
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Figure 29. View and Change Document Properties Window 2
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Using the Command Line

This section explains how to determine the media and finisher requirements using the command line in a
dtterm or AIX window.

Media Determination

To use the command line to determine the media requirements, you will use the host name and job name.
To find the host name and job name:

1. Host name - type hostname and press Enter. You see the host name.

2. Job name - Use the Destination Queue window 1 (Figure 25 on page 27) to find the job name in the
″Name″ column.

To determine the media requirements for the print job:

1. Type pdls -U servername: | grep jobname and press Enter. For example:
FourTifffs.jtk.00l thyme:3410300009 FourTiffs.jtk held

Where:
Job ID FourTifffs.jtk.00l
Host (Server) thyme
Global Job ID 3410300009
Name FourTffs.jtk

2. Type pdls -U -rall thyme:3410300009 | grep medium and press Enter. For example:
thyme:3410300009 default-medium = ledger

Finisher Requirements

To determine the finisher requirements’:

1. Type pdls -U -rall thyme:3410300009 | grep finishing and press Enter. For example:
thyme:3410300009 Job-finishing = staple-top left
thyme:3410300009 document-finishing = z-fold

Using Inserts

An insert is a pre-printed or blank sheet that the InfoPrint 60 printer will insert without additional printing.
You can use any input bin in the InfoPrint 60 printer or input bin on the finisher as an insert tray.

In the MPC (server), you can define the media as insert1, insert2, and so on. The dimensions of the
defined media (insert1) are not important when the media is used as an insert.

The media ″supported″ function in the InfoPrint 60 printer must be selected.

You can submit jobs with one or more insert sheets using the defined media (insert1 and so on). An
example of items with corresponding media for a job is:

Item Media
Insert A insert1
ps file letter
insert A insert1
ps file2 letter
insert B insert2
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Finishing Examples

This section contains examples using default settings. The default setting were set using this procedure:

1. Select the Print tab in the InfoPrint Submit Job Ticket window (Figure 30).

2. For ″Printer type″, select ″InfoPrint 60″.

3. Select Options → Preferences .

4. You see the Preferences window (Figure 31 on page 34). For ″Printer type″, select ″InfoPrint 60″.

5. Select OK. Every new job ticket uses the InfoPrint 60 as the default printer.
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Figure 30. InfoPrint Submit Job Ticket Window - Print Tab
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6. To set schedule options, select the ″Schedule tab″. You see the Preferences - Schedule tab
(Figure 32). Select the radio button that applies to your application. For example, if you are submitting
Post Script (PS) files or requesting paper from an insert tray, select the ″RIP and hold″ radio button.
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Figure 31. Preferences - Print Tab
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Figure 32. Preferences - Schedule Tab
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Edge-Stitched Document with Front Cover

This example shows a cover page that is placed in the finisher insert or input tray and the document from
the printer being stapled.

1. From the InfoPrint Submit Job Ticket window (Figure 33), insert the sheets and files to be printed or
finished:

a. Insert a sheet by selecting the Insert Sheet toolbar button or by selecting Item → Insert Sheet .

b. Insert a PS file by selecting the Insert File toolbar button or by selecting Item → Insert File .

2. Select the ″Layout″ tab. You see Figure 33.

3. From the ″Finishing″ drop-down menu, select ″Two staples″.

4. Specify ″Layout″ and ″Sides″ as needed.

5. Leave the ″Use form definition″ field blank because a form definition is not required for this example.

Note: If the ″Finishing″ drop-down menu is disabled (grayed out), submit has not been refreshed with
the server after a printer with finishing options was defined. If such a printer has been defined
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Figure 33. Edge-Stitched Document with Front Cover - Layout Tab
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on the server, you can select Options → Refresh to enable the Finishing drop-down menu. If
this does not work or you need instructions about creating a printer with finishing options on the
server, see “Setting Up the Server” on page 13.

6. To differentiate between printing and inserting preprocessed sheets, a media must be defined on the
server (see “Defining the Media” on page 15). The server administrator or operator knows the paper
names for the insert sheets, so you can consult them if the name is not obvious from the Paper
drop-down list.

7. From the document, select the ″Sheet 1″. You see the Sheet tab (Figure 34).

8. From the Paper drop-down menu, select the paper that corresponds to the desired insert media sheet.

Note: The insert media sheet is defined at the MPC. You submit your print job with hold. When the
operator views your job, the operator loads the pre-printed pages into the input tray defined by
the media statement in the MPC.

9. Submit the job: Ticket → Submit Job .
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Figure 34. Edge-Stitched Document with Front Cover - Sheet
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Edge-Stitched Document with Tabbed Inserts

In this example, a document is printed on the InfoPrint 60 and the finisher inserts tabs.

1. From the InfoPrint Submit Job Ticket window (Figure 35), insert the sheets and files to be printed or
finished:

a. Insert a sheet by selecting the Insert Sheet toolbar button or by selecting Item → Insert Sheet .

b. Insert a PS files by selecting the Insert File toolbar button or by selecting Item → Insert File .

2. Select the ″Layout″ tab. You see Edge-Stitched Document with Tabbed Inserts - Layout Figure 35.

3. Define the ″Sheet 1″ using the method in “Edge-Stitched Document with Front Cover” on page 35.

4. From the ″Finishing″ drop-down menu, select ″Three staples″.

5. For the Insert Sheet, select the paper corresponding to insert sheets as explained in “Edge-Stitched
Document with Front Cover” on page 35. The Insert Sheets are tabs placed in the input or insert tray
of the finisher.

6. Submit the job: Ticket → Submit Job .
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Figure 35. Edge-Stitched Document with Tabbed Inserts - Layout Tab
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Edge-Stitched Document with Z-Folded Sheets

In this example, a document contains z-folded sheets.

1. From the InfoPrint Submit Job Ticket window (Figure 36).

2. Insert the GIF, PS, JPEG, and PS files by selecting the Insert File toolbar button or by selecting Item →
Insert File .

3. From the Finishing drop-down menu, select ″Two staples″.

4. Select the ″Print″ tab. You see the print tab window (Figure 37 on page 39).
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Figure 36. Edge-Stitched with Z-Folded Sheets - Layout Tab
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5. The .gif and .ipg sheets need to be z-folded:

a. Select the file to be z-folded (.gif).

b. Select the ″Show More″ button.

c. Select the Print tab.

d. From the Paper drop-down menu, select ledger.

e. Select ″z-fold″.

f. Set the ″Number of pages″ to 1.

g. Repeat these steps for the .ipg file.

6. Submit the job: Ticket → Submit Job .

c2
pi

00
72

Figure 37. Edge-Stitched with Z-Folded Sheets - Print Tab
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Saddle-Stitched 2-UP Document

In this example, a document is saddle stitched using 2-UP: (2 - 8.5 x 11 on ledger (11 x 17) with two
staples (default).

1. From the InfoPrint Submit Job Ticket window (Figure 38), insert the files to be printed or finished:

v Insert a PS file by selecting the Insert File toolbar button or by selecting Item → Insert File .

2. From the ″Layout″ drop-down menu, select ″Booklet 2-up″.

3. The ″Sides″ drop-down menu automatically selects Duplex (inferred by Booklet).

4. From the ″Finishing″ drop-down menu, select ″Saddle staple″.

5. Select the Print tab. You see the Saddle Stitched 2-UP Document - Layout Tab widow (Figure 39 on
page 41).
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Figure 38. Saddle Stitched 2-UP Document - Layout Tab
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6. From the ″Paper″ drop-down menu, select ledger paper.

7. Submit the job: Ticket → Submit Job .
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Figure 39. Saddle Stitched 2-UP Document - Print Tab
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Edge-Stitched on Right

In this example, a document is stapled on the right side of the page.

To put three staples on the non-leading-edge of a document (right for long-edge fed or bottom for
short-edge fed), you must use a form definition (F1FER010). For example:

FORMDEF NAME REPLACE YES
FINISH SCOPE PRINTFILE
OPERATION EDGE REFERENCE RIGHT OPCOUNT 3 ;

For more information about form definitions, see “Chapter 5. Form Definition and PPFA” on page 75.

1. In the InfoPrint Submit Job Ticket window (Figure 40), insert the files to be printed or finished:

a. Insert a PS file by selecting the Insert File toolbar button or by selecting Item → Insert File .

2. From the ″Layout″ tab, enter the name of the form definition in the ″Use form definition″ field.

Note: When you use a form definition, the form definition overrides any finishing or printing selections.

3. Submit the job: Ticket → Submit Job .
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F1FER010

Figure 40. Edge-Stitched on Right - Layout Tab
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Note: Setup the printer input tray, that is selected, so that the paper is long-edge fed.

Chapter 2. Printing with InfoPrint Manager 43



Top Left Corner Staple

In this example, a document has one staple in the top left corner.

1. Form the InfoPrint Submit Job Ticket window (Figure 41), insert the file to be printed or finished:

a. Insert the PS file by selecting the Insert File toolbar button or by selecting Item → Insert File .

2. From the ″Finishing″ drop-down menu, select ″Top corner″.

3. Submit the job: Ticket → Submit Job .

Note: Set up the paper in the selected printer input tray selected, so the paper is short-edge fed.
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Figure 41. Top Left Corner Staple
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Edge-Stitch 2 Left

In this example, a document has 2 staples on the left side.

1. From the InfoPrint Submit Job Ticket window (Figure 42), insert the files to be printed or finished.

a. Insert a PS file by selecting the Insert File toolbar button or by selecting Item → Insert File .

2. From the ″Finishing″ drop-down menu, select ″Two staples″

3. Submit the job: Ticket → Submit Job .

Note: Set up the printer input tray selected so the paper is long-edge fed.
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Figure 42. Edge-Stitch 2 Left - Layout Tab
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Z-Fold 2-UP Sheets

In this example, a document has z-folded pages and printing 2-UP.

1. In the InfoPrint Submit Job Ticket window (Figure 43), Insert the file(s) to be printed or finished.

v Insert the PS files by selecting the Insert File toolbar button or by selecting Item → Insert File .

2. Select the Layout tab. You see Figure 43.

3. From the ″Finishing″ drop-down menu select ″None″ for no stapling.

4. Select the Print tab. You see Z-Fold 2-UP Sheets - Print Tab (Figure 44 on page 47).

5. Select the page to be z-folded.

6. For each page to be z-folded:

a. From the ″Paper’’ drop-down menu, select ledger or A3 paper.

b. Select ″Z-fold″.

7. Submit the job: Ticket → Submit Job .
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Figure 43. Z-Fold 2-UP Sheets - Layout Tab

46 InfoPrint 60 Finisher Application Design Guide



c2
pi

00
79

Figure 44. Z-Fold 2-UP Sheets - Print Tab
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Chapter 3. Printing with PSF/MVS

This chapter explains how to print and finish booklets and documents with the IBM InfoPrint 60 finisher
Print Services Facility/MVS 2.2.0 (PSF/MVS) installed on an MVS or OS/390 system. This chapter
contains information for the system programmer who customizes PSF/MVS and for job submitters.

To fully understand this chapter, you must have some knowledge of PSF/MVS. For information about
PSF/MVS, see PSF/MVS Application Programming Guide, S544-3673, and the PSF/MVS System
Programming Guide, S544-3672.

Be sure you have read “Chapter 1. InfoPrint 60 Finisher Introduction” on page 1 before you use this
chapter.

For examples of printing and finishing, see “Finishing Examples” on page 86.

Customizing PSF/MVS

To install PSF/MVS 2.2.0 support for the InfoPrint 60 finisher, the system programmer must apply the PTF
associated with PSF/MVS APAR OW24360.

Use the standard procedure described in the PSF/MVS System Programming Guide, S544-3672 to define
the InfoPrint 60 printer to JES and PSF/MVS. However, use the procedures in this section to define the
InfoPrint 60 printer to JES and to install form definitions for the finisher.

Defining the InfoPrint 60 Finisher to JES

When you define the InfoPrint printer to JES, you might want to limit the size of jobs that JES directs to
the printer. For example, the InfoPrint 60 finisher can staple a maximum of 50 sheets because of their
thickness. If a print job or document is larger than the maximum allowed, the print jobs print as usual but
the finisher does not staple as requested; PSF/MVS prints a warning message at the end of the print job.
To limit the size of jobs directed to a printer, use these JES initialization statement parameters:

v In a JES2 environment, use the PLIM, LIMIT, and WS=LIM parameters of the PRT(nnnn) statement.
See the JES2 Initialization and Tuning Reference, SC23-0083 for your level of the operating system for
information about the PRT(nnnn) statement.

v In a JES3 environment, use the PAGELIM, LINELIM, and WS=L parameters of the DEVICE statement.
See the JES3 Initialization and Tuning Reference, SC23-0083 for your level of the operating system for
information about the DEVICE statements.

For example, you could set the PLIM or PAGELIM value to 50 so that the printer accepts only print files
with 50 or less pages. Note that JES counts pages in the entire print file. Some print files might contain
more than 50 pages, but documents within that print file may contain less than 50 pages. Therefore, the
PLIM parameter is useful for limiting jobs only if all print files contain only one document per print file or if
stapling is always requested at the print file level.

You also might want to consider assigning similar JES work-selection criteria to several InfoPrint 60
printers so that job submitters can print to any printer in a group of InfoPrint 60 printers. For example, if
three InfoPrint 60 printers are in the same room, you can define the printers to JES so that each printer
selects jobs with the same output class or destination. If one of the printers has the finisher installed and is
used for stapling, you can use JES work-selection parameters to limit that printer to print jobs that contain
less than 50 pages.
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Installing Form Definitions

IBM provides a set of form definitions that job submitters can use to control the finisher. You can use ftp to
obtain these form definitions from the IBM Printing Systems Company Web site. See “Sample Form
Definitions” on page 85 for information about the IBM-supplied form definitions and about how to use
PPFA. An application programmer can use the Page Printer Formatting Aid (PPFA) or a similar product to
modify these form definitions or to create new ones.

To make the finisher form definitions available to all job submitters, you can put the new form definitions
(1) in the same PSF system library that contains other form definitions or (2) in a separate PSF user or
system library reserved for finisher form definitions. Consider these points when deciding where to install
the finisher form definitions:

v If you put the finisher form definitions in the same system library with other form definitions, the form
definitions will be available to all printers. If a print job requests a form definition that specifies a
finishing option but the printer does not have the finisher installed, the job prints as usual but the
finishing requested in the form definition is ignored; PSF/MVS prints a warning message at the end of
the print job.

v If you put the finisher form definitions in a separate library, you can make that library available in the
PSF startup procedure only for the printers that have the finisher installed. See the PSF/MVS System
Programming Guide, S544-3672 for information about PSF startup procedures.

When you create a separate library for finisher form definitions, the finisher form definitions can have
the same names as existing form definitions that are in another library, thereby eliminating the need for
job submitters to name a different form definition when printing to an InfoPrint 60 finisher. For example,
if all print jobs printed on an InfoPrint 60 finisher are to be stapled, you could rename the form
definitions that request stapling, using the same names as comparable form definitions that do not
request stapling. Place the form definitions that request stapling in the form definition library defined
only to the InfoPrint 60 finisher. When job submitters print to the InfoPrint 60 finisher, PSF uses a
finisher form definition; when job submitters print to a printer without the finisher, PSF uses a
non-finisher form definition.

Submitting a Print Job

To request one of the finishing options (for example: stapling, saddle-stitching), the job submitter must first
select a form definition that requests the desired finishing option. You can select one of the IBM-supplied
form definitions. Your system programmer may have put these form definitions in a PSF system or user
library for you to use. If the IBM-supplied form definitions do not satisfy your needs, you can use PPFA or
a similar program to modify one of the form definitions or create your own. If you want different pages of
your print job to use different finishing options, you can create a form definition with different copy groups
(medium maps) and modify your print file to use the desired medium map (see “Finishing Examples” on
page 86).

After you have selected a form definition, you name it on the OUTPUT statement in your Job Control
Language (JCL). If you use OS/390 UNIX System Services, you can name the form definition on the lp
command.

For example, to staple each document in a print file using form definition F1FC0011 located in a PSF
system library, use the following JCL:
//AFPUSER JOB ...
//STEP1 EXEC PGM=USERA
//OUT1 OUTPUT FORMDEF=FC0011
//PRINT DD SYSOUT=A,OUTPUT=(*.OUT1)
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Note: When the finisher is installed and the form definition requests a finishing option, the InfoPrint 60
uses the appropriate output bin by default. Therefore, you do not need to specify the output bin
when you submit a print job.

See the PSF/MVS Application Programming Guide, S544-3673 for other examples of how to send print
jobs to PSF/MVS.
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Chapter 4. Printing with AS/400

This chapter explains how to print and finish booklets and documents with the IBM InfoPrint 60 finisher
and the AS/400. This chapter contains information for the system programmer to customize print jobs.

Be sure you have read “Chapter 1. InfoPrint 60 Finisher Introduction” on page 1 before you use this
chapter.

Availability of PSF/400 Programming Support for Finishing

PSF/400 programming support for IPDS printers that support finishing operations is provided in releases
V4R2 and V4R3.

Support is provided for:

1. Corner staple

2. Edge stitch

3. Saddle stitch

4. Z-Fold (by form definition only)

5. Insert (by normal input bin selection)

For V4R2, the support is provided by APAR.

For V4R3, new printer file parameters CORNERSTPL and EDGESTITCH have been added. Support for
using the USRDFNDTA parameter to pass in the SADLSTITCH parameter will be provided by APAR.

Table 8 shows where you can specify a finishing operation according to the release.

Table 8. AS/400 Finishing Support for V4R2 and V4R3

Operation V4R2 V4R3

Form
Def

Printer File DDS Form
Def

Printer File DDS

Corner
Staple

Yes USRDFNDTA No Yes CORNERSTPLNo

Edge-Stitch Yes USRDFNDTA No Yes EDGESTITCH No

Saddle Stitch Yes USRDFNDTA No Yes Planned No

Z-Fold Yes No No Yes No No

Insert Yes DRAWER DRAWERYes DRAWER DRAWER

Yes - Is used in the Form Def column to indicate support by a form definition
created by PPFA/400. See the product’s manual for information about specifying the
particular finishing operation.

No - Means that an operation is not supported by the indicated method.

Under Printer File and DDS, use the parameter or keyword as shown.

Planned - Means the specified operation will be offered by PTF at a future date.

Support for new finishing operations and support for releases other than V4R2 and V4R3 may be provided
in the future. Check with your IBM Printing Systems Company representative for availability.
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Specifying Finishing Operations

You can specify finishing operations in a printer file or in a form definition.

Form Definition Method

To use a form definition, specify the name and library of the form definition in the FORMDF parameter of
the CRTPRTF, CHGPRTF, or OVRPRTF commands.

If the form definition requests a single finishing operation applied to entire print job, specify the form
definition name in FORMDF parameter. This applies the finishing operation requested in the form definition
to the entire print job.

Sometimes a more complex form definition is necessary; for example, one that contains a copygroup for
z-folded pages and a copygroup for document pages. In this case, where the form definition contains
multiple copygroups, use the INVMMAP (Invoke Medium Map) DDS keyword to switch between them.

Notes:

1. The INVMMAP keyword is only valid with DEVTYPE(*AFPDS).

2. The terms ″medium map″ and ″copy group″ are synonymous. PPFA uses the term ″copy group″.
AS/400 uses the term ″medium map″. Use the INVMMAP keyword to switch between copy groups.

Printer File Method

Support for stapling operations exists on these releases: V4R3 and V4R2. These operations are specified
using the CRTPRTF CHGPRTF, OVRPRTF commands

Version V4R3M0

For version V4R3, these parameters have been added to the printer file:

v CORNERSTPL

v EDGESTITCH

Support for saddle stitch will be made available at a later date through PTFs.

Printer files migrated from V4R2 that specify a finishing operation using the USRDFNDTA parameter are
supported on V4R3. Use the value specified using the USRDFNDTA parameter only if a corresponding
new parameter in the printer file has a value of *NONE. For example, only if CORNERSTPL(*NONE) is
specified, a specification of CORNERSTPL using USRDFNDTA will be used.

This CRTPRTF command shows a simple edge stitch request specified with the EDGESTITCH parameter:
CRTPRTF FILE(prtf_name) EDGESTITCH(*LEFT *DEVD 3 *DEVD)

This CRTPRTF command shows a corner staple request specified with the CORNERSTPL parameter:
CRTPRTF FILE(prtf_name) CORNERSTPL(*DEVD)

Version V4R2M0

To requests corner staple, edge stitch, and saddle stitch specify the appropriate free-form text string in the
USRDFNDTA parameter of the printer file.

This CRTPRTF command shows a saddle stitch request specified with the USRDFNDTA parameter:
CRTPRTF FILE(prtf_name) USRDFNDTA('SADLSTITCH(*DEVD *DEVD (*DEVD))')
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Syntax

This section explains each finishing operation that can be specified with the printer file. It also explains the
corresponding syntax required for specification with the USRDFNDTA parameter.

You can specify three finishing options with a printer file: corner staple, edge-stitch, and saddle stitch. You
must specify each of these using the USRDFNDTA parameter of the printer file. The USRDFNDTA
parameter permits the input of free-form text using these CL commands: CRTPRTF, CHGPRTF, or
OVRPRTF. Syntax checking is not performed when you enter the text.

Corner Staple

Specifies the reference corner to be used for a corner staple. A staple is driven into the media at the
reference corner. See Figure 1 on page 2 for the reference corners that are supported. Page rotation does
not affect the placement of a corner staple.

Corner Staple Syntax

USRDFNDTA('CORNERSTPL(reference_edge)')

The following reference edges may be specified:

v *NONE

A corner staple is not specified. This is the same as not specifying CORNERSTPL.

v *DEVD

The reference corner is the default reference corner used by the device.

v *BOTRIGHT

The reference corner is the bottom right corner of the media.

v *TOPRIGHT

The reference corner is the top right corner of the media.

v *TOPLEFT

The reference corner is the top left corner of the media.

v *BOTLEFT

The reference corner is the bottom left corner of the media.

Syntax Notes:

1. Upper, lower, or mixed case is acceptable.

2. Spaces may not be inserted anywhere in the string that specifies a corner staple.

3. Here is an example of a syntactically correct specification of a corner staple:
USRDFNDTA('CORNERSTPL(*TOPLEFT)')

Edge Stitch

Specifies where staples are to be placed along the finishing margin of the media. Check your printer
documentation to determine which elements, and which values of elements, are supported. Where your
printer does not support any of the values for a specific element, specify a value of *DEVD for the
element.

Note: The finishing margin is an invisible line along which finishing operations, such as edge stitching, are
done. You specify the distance from the edge of the paper in the reference edge offset element of
the parameter.
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Edge Stitch Syntax

Reference edge - Specifies the reference edge to be used for an edge stitch. An edge stitch is formed by
having one or more staples driven into the media along the finishing margin. Possible values are:

v *NONE

An edge stitch is not specified. This is the same as not specifying EDGESTITCH.

v *DEVD

The default that is used by the device.

v *BOTTOM

The reference edge is the bottom edge.

v *LEFT

The reference edge is the left edge.

v *RIGHT

The reference edge is the right edge.

v *TOP

The reference edge is the top edge.

Reference edge offset - Specifies the offset from the reference edge to place the edge stitching:

v *DEVD

The default staple offset for the device. *DEVD is the only value you can specify for the InfoPrint 60
finisher.

Number of staples - Specifies the number of staples to use for edge stitching. Possible values are:

v *DEVD

The default staple offset for the device.

v You may specify 2 or 3 staples for the InfoPrint 60 finisher.

Staple-offsets - Specifies the distance between staples that are used in the edge stitching. Possible
values are:

v *DEVD

The default staple offset for the device. *DEVD is the only value you can specify for the InfoPrint 60
finisher.

Syntax Notes:

1. Upper, lower, or mixed case is acceptable.

2. Spaces must be inserted between each value contained within the outermost pair of parentheses.

Note: Staple offsets are contained within an extra set of parentheses. Both the parentheses and value
for staple offsets are considered a single value.

3. Here is a example of a syntactically correct specification of an edge stitch:
USRDFNDTA('EDGESTITCH(*LEFT *DEVD 3 (*DEVD))')

Saddle Stitch

Specifies where staples are to be placed along the finishing margin, which is positioned at the center of
the media. For saddle stitch, the finishing margin is an invisible line positioned at the center of the media
parallel to the reference edge.

USRDFNDTA('EDGESTITCH(reference_edge reference_edge_offset number_of_staples (staple_offsets))')
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Saddle Stitch Syntax

USRDFNDTA('SADLSTITCH(reference_edge number_of_staples (staple_offsets))'

Reference edge - Specifies which edge to use as the finishing edge. Possible values are:

v *NONE.

A saddle stitch is not specified. This is the same as not specifying SADLSTITCH.

v *DEVD

The default staple offset for the device. *DEVD is the only value you can specify for the InfoPrint 60
finisher.

Number of staples

v *DEVD

The default value for the device. *DEVD is the only value you can specify for the InfoPrint 60 finisher.

Staple offsets - Specifies the distance between staples that are used in the edge stitching. Possible
values are:

v *DEVD

The default staple offset for the device. *DEVD is the only value you can specify for the InfoPrint 60
finisher.

Syntax Notes:

1. Upper, lower, or mixed case is acceptable.

2. Spaces must be inserted between each value contained within the outermost pair of parentheses.

Note: Staple offsets are contained within an extra set of parentheses. Both the parentheses and value
for staple offsets are considered a single value.

3. Here is an example of a syntactically correct specification of a saddle stitch:
USRDFNDTA('SADLSTITCH(*DEVD *DEVD (*DEVD))')

AS/400 Finisher Examples

This section contains examples that show you how to use a printer file and DDS keywords to perform
various finishing options. The examples use the C programming language.

These examples show the complete C program source, DDS source, and printer file used in the first
example (“Edge-Stitched Document with Front Cover” on page 63). The program source, DDS source, and
printer file are the basis for all the examples in this section.
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Sample Program Source

Figure 45 and Figure 46 on page 59 show the program source for “Edge-Stitched Document with Front
Cover” on page 63.

/*
* Program name . . . . . . . . . . . . . . . . . . . : EXMP1V4R2
* Library name . . . . . . . . . . . . . . . . . . . : CET
* Last update . . . . . . . . . . . . . . . . . . . : 08/20/98
* Text . . . :
* This source program is used
* to illustrate examples of finishing.
*
* This file, as shown, in conjunction with the printer file will
* produce a cover page and a sheet with some print data edge
* stitched together.
*
*
*/
#include "prtdef.h" /* Contains source for PUT function */
#include #include
#define PRTF "CET/EXMP1V4R2"

main()
{

FILE *fp;

errno = 0;

/********************************************************************/
/* Open the printer file for output. */
/********************************************************************/
fp = fopen(PRTF,"wb type=record lrecl=80");
if(errno) {
printf("%s (while opening %S\n",strerror(errno), PRTF);
exit(1);

}

/********************************************************************/
/* Write a null string using RCD1. This will pull a sheet from the */
/* insert bin. In this case, the insert bin is bin 7. */
/* */
/********************************************************************/
PUT("",
"RCD1 ",fp);

/********************************************************************/
/* Write application data using RCD2. This pulls from bin 1. */
/********************************************************************/
PUT("This is a data page.",
"RCD2 ",fp);

fclose(fp);
}

Figure 45. Sample .C Program Source (EXMP1V4R2.C)
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/*
* Header name . . . . . . . . . . . . . . . . . . . . . : PRTDEF
* Library name . . . . . . . . . . . . . . . . . . . . : CET
* Text . . . :
* Header file used in C finishing example
*/
#include #include #include #include
void PUT(char *text,char *rcdfmt,FILE *fp); /* prototype */
/**********************************************************************/
/* PUT places the data string pointed to in *text into the spool */
/* file. This spool file must be opened in a way similar to: */
/* */
/* fp = fopen(DDS_FILE,"wb type=record lrecl=80"); */
/* */
/* Where DDS_FILE is a string containing the DDS printer file name. */
/* */
/* The format must at least contain "wb type=record", but having */
/* lrecl defined is suggested. */
/* */
/* *rcdfmt corresponds to a record format name found in DDS_FILE, and */
/* *fp corresponds to the pointer associated with the opened file. */
/* PUT automatically pads *rcdfmt with spaces if its length is less */
/* than ten, or truncates if greater than ten. */
/**********************************************************************/

void PUT(char *text,char *rcdfmt,FILE *fp)
{
int i;
char temp[11]; /* holds the padded record format */

strcpy(temp,rcdfmt);
if (strlen(temp) < 10)
{
for(i = strlen(temp);i<10;i++) /* Pad the record format */
temp[i] = ' ';

temp[10] = '\0';
}
else if (strlen(temp) > 10)
temp[10] = '\0';

_Rformat((_RFILE *) fp,temp);
fwrite(text,1,strlen(text),fp);

}

Figure 46. Sample .H Code (PRTFEF.H)
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Sample DDS Source

Figure 47 shows the DDS source for “Edge-Stitched Document with Front Cover” on page 63.

5769PW1 V4R2M0 980228 SEU SOURCE LISTING 08/26/98 16:37:24
SOURCE FILE . . . . . . . CET/DDSSRC
MEMBER . . . . . . . . . EXMP1V4R2
SEQNBR*...+... 1 ...+... 2 ...+... 3 ...+... 4 ...+... 5 ...+... 6 ...+... 7 ...+... 8 ...+... 9 ...+... 0
100 **************************************************************
200 *
300 * Description: Print a finishing example using the DDS code
400 * to define the drawers to pull from. Bin 7 for a
500 * cover page and bin 1 for a regular sheet.
600 * The CRTPRTF command will include
700 * a parm to define the EDGESTITCH for the
800 * document.
900 *
1000 * Create print file with the following options:
1100 *
1200 * CRTPRTF FILE(CET/EXMP1V4R2) PAGESIZE(66 85) +
1300 * SRCFILE(CET/DDSSRC) SRCMBR(*FILE) +
1400 * DEVTYPE(*AFPDS) USRDFNDTA('EDGESTITCH(*LEFT +
1500 * *DEVD 2 (*DEVD))')
1600 *
1700 **************************************************************
1800 *
1900 * set up the cover sheet with no data on it.
2000 *
2100 R RCD1 ENDPAGE
2200 DRAWER(7)
2300 FLD1 40A POSITION(1.0 1.0)
2400 *
2500 * Pull regular sheets from drawer 1
2600 *
2700 R RCD2 DRAWER(1)
2800 FLD2 40A 1SKIPB(5)

* * * * E N D O F S O U R C E * * * *

Figure 47. Sample DDS Source (EXMP1V4R2)
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Sample Printer File

Figure 48 through Figure 50 on page 63 show the printer file for “Edge-Stitched Document with Front
Cover” on page 63.

5716SS1 V4R2M0 980228 Display File Description
File . . . . . . . . . . . : EXMP1V4R2

Library . . . . . . . . . : CET
Type of information . . . . : *ALL
File attributes . . . . . . : *PRTF
System . . . . . . . . . . : *LCL
Processor . . . . . . . . . : IBM AS/400 Display File Description Processor

File . : EXMP1V4R2 Library . : CET Type of file . : Printer
Device File Attributes

Externally described file . . . . . . . . . : Yes
File level identifier . . . . . . . . . . . : 0980826152036
Creation date . . . . . . . . . . . . . . . : 08/26/98
Text 'description' . . . . . . . . . . . . : TEXT Finishing example 1 - no formdef
Spool the data . . . . . . . . . . . . . . : SPOOL *YES
Maximum devices . . . . . . . . . . . . . . : 1
User specified DBCS data . . . . . . . . . : IGCDTA *NO
DBCS capable . . . . . . . . . . . . . . . : No
Maximum file wait time . . . . . . . . . . : WAITFILE *IMMED
Share open data path . . . . . . . . . . . : SHARE *NO
Record format level check . . . . . . . . . : LVLCHK *YES
Number of record formats . . . . . . . . . : 2
User buffer length . . . . . . . . . . . . : 40
Number of devices . . . . . . . . . . . . . : 1
Separate indicator area . . . . . . . . . . : INDARA No

Printer Attributes
Device . . . . . . . . . . . . . . . . . . : DEV *JOB
Printer device type . . . . . . . . . . . . : DEVTYPE *AFPDS
Page size PAGESIZE
Length . . . . . . . . . . . . . . . . . : 66
Width . . . . . . . . . . . . . . . . . . : 132
Measurement Method . . . . . . . . . . . : *ROWCOL

Lines per inch . . . . . . . . . . . . . . : LPI 6
Characters per inch . . . . . . . . . . . . : CPI 10
Front margin . . . . . . . . . . . . . . . : FRONTMGN *DEVD
Back margin . . . . . . . . . . . . . . . . : BACKMGN *FRONTMGN
Overflow line number . . . . . . . . . . . : OVRFLW 60
Fold records . . . . . . . . . . . . . . . : FOLD *NO
Degree of page rotation . . . . . . . . . . : PAGRTT *AUTO
Hardware justification . . . . . . . . . . : JUSTIFY 0
Print on both sides . . . . . . . . . . . . : DUPLEX *NO
Defer Write . . . . . . . . . . . . . . . . : DFRWRT *YES
Unprintable character action RPLUNPRT
Replace character . . . . . . . . . . . . : *YES
Replacement character . . . . . . . . . . : ' ' X'40'

Figure 48. Sample Printer file, Sheet 1
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Replacement character . . . . . . . . . . : ' ' X'40'
Print text . . . . . . . . . . . . . . . . : PRTTXT *JOB
Align page . . . . . . . . . . . . . . . . : ALIGN *NO
Control character . . . . . . . . . . . . . : CTLCHAR *NONE
Channel values . . . . . . . . . . . . . . : CHLVAL *NORMAL
Fidelity . . . . . . . . . . . . . . . . . : FIDELITY *CONTENT

5716SS1 V4R2M0 980228 Display File Description
File . : EXMP1V4R2 Library . : CET Type of file . : Printer

Device File Attributes
Printer quality . . . . . . . . . . . . . . : PRTQLTY *STD
Form feed . . . . . . . . . . . . . . . . . : FORMFEED *DEVD
Source drawer . . . . . . . . . . . . . . . : DRAWER 1
Output bin . . . . . . . . . . . . . . . . : OUTBIN *DEVD
Font FONT
Identifier . . . . . . . . . . . . . . . : *CPI
Point size . . . . . . . . . . . . . . . : *NONE

Character identifier . . . . . . . . . . . : CHRID *DEVD
Decimal format . . . . . . . . . . . . . . : DECFMT *JOB
Font character set . . . . . . . . . . . . : FNTCHRSET *FONT
Coded font . . . . . . . . . . . . . . . . : CDEFNT *FNTCHRSET
Table Reference Characters . . . . . . . . : TBLREFCHR *NO
AFP Chars . . . . . . . . . . . . . . . . . : AFPCHARS *NONE
Page definition . . . . . . . . . . . . . . : PAGDFN *NONE
Form definition . . . . . . . . . . . . . . : FORMDF *NONE
Form type . . . . . . . . . . . . . . . . . : FORMTYPE *STD
Pages per side . . . . . . . . . . . . . . : MULTIUP 1
Reduce output . . . . . . . . . . . . . . . : REDUCE *TEXT
Unit of measure . . . . . . . . . . . . . . : UOM *INCH
Front side overlay . . . . . . . . . . . . : FRONTOVL *NONE
Back side overlay . . . . . . . . . . . . . : BACKOVL *FRONTOVL
DBCS extension characters . . . . . . . . . : IGCEXNCHR *YES
DBCS character rotation . . . . . . . . . . : IGCCHRRTT *NO
DBCS characters per inch . . . . . . . . . : IGCCPI *CPI
DBCS SO/SI spacing . . . . . . . . . . . . : IGCSOSI *YES
DBCS Coded font . . . . . . . . . . . . . . : IGCCDEFNT *SYSVAL

5716SS1 V4R2M0 980228 Display File Description
File . : EXMP1V4R2 Library . : CET Type of file . : Printer

Spooling Description
Spooled output queue . . . . . . . . . . . : OUTQ *JOB
Max spooled output records . . . . . . . . : MAXRCDS 100000
Spooled output schedule . . . . . . . . . . : SCHEDULE *FILEEND
Copies . . . . . . . . . . . . . . . . . . : COPIES 1
Page range to print PAGERANGE
Starting page . . . . . . . . . . . . . . : 1
Ending page . . . . . . . . . . . . . . . : *END

File separators . . . . . . . . . . . . . . : FILESEP 0
Hold spooled file . . . . . . . . . . . . . : HOLD *NO
Save spooled file . . . . . . . . . . . . . : SAVE *NO
Output priority (on OUTQ) . . . . . . . . . : OUTPTY *JOB
User data . . . . . . . . . . . . . . . . . : USRDTA *SOURCE
Spool file owner . . . . . . . . . . . . . : SPLFOWN *CURUSRPRF

*NONE

Figure 49. Sample Printer file, Sheet 2

62 InfoPrint 60 Finisher Application Design Guide



Edge-Stitched Document with Front Cover

Figure 51 shows a cover page that is placed in the finisher insert or input tray and the document from the
printer being stapled.

This example selects the front cover from the insert tray (bin 7) and selects the remainder of the document
from bin 1. The complete source code for this example is shown in “AS/400 Finisher Examples” on
page 57. The entire document is stapled on the left edge with two staples.

DDS Source

Use the DDS keyword DRAWER to select the appropriate input bin. Figure 52 on page 64 shows the DDS
source.

User defined option . . . . . . . . . . . . : USRDFNOPT
User defined data . . . . . . . . . . . . . : USRDFNDTA EDGESTITCH(*LEFT *

DEVD 2 (*DEVD))
User defined object USRDFNOBJ
Object . . . . . . . . . . . . . . . . . : *NONE
Library . . . . . . . . . . . . . . . . :

Object type . . . . . . . . . . . . . . . :
5716SS1 V4R2M0 980228 Display File Description
File . : EXMP1V4R2 Library . : CET Type of file . : Printer

Record Format List
Record Format Level Point Page Lines Character Size

Format Fields Length Identifier Font Size Rotation Per Inch Width Height
RCD1 1 40 157093531C1C7

Text . . . :
RCD2 1 40 157093632C1C7

Text . . . :
Total number of formats . . . . . . . . . : 2
Total number of fields . . . . . . . . . . : 2
Total record length . . . . . . . . . . . : 80

Figure 50. Sample Printer file, Sheet 3
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Figure 51. Edge-Stitched Document with Front Cover
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CRTPRTF Command

Specify the EDGESTITCH parameter in the USRDFNDTA parameter.
CRTPRTF FILE(CET/EXMP1V4R2) PAGESIZE(66 85) +

SRCFILE(CET/DDSSRC) SRCMBR(*FILE) +
DEVTYPE(*AFPDS) +
USRDFNDTA('EDGESTITCH(*LEFT *DEVD 2 (*DEVD))')

Program Source

Figure 53 on page 65 shows the code fragment for the cover sheet being pulled from bin 7 by using the
RCD1 record format. No data is written with this format; its purpose is to pull the cover sheet. The
application data is written using the RCD2 record format, which pulls paper from bin 1.

5769PW1 V4R2M0 980228 SEU SOURCE LISTING 08/26/98 16:37:24
SOURCE FILE . . . . . . . CET/DDSSRC
MEMBER . . . . . . . . . EXMP1V4R2
SEQNBR*...+... 1 ...+... 2 ...+... 3 ...+... 4 ...+... 5 ...+... 6 ...+... 7 ...+... 8 ...+... 9 ...+... 0
100 **************************************************************
200 *
300 * Description: Print a finishing example using the DDS code
400 * to define the drawers to pull from. Bin 7 for a
500 * cover page and bin 1 for a regular sheet.
600 * The CRTPRTF command will include
700 * a parm to define the EDGESTITCH for the
800 * document.
900 *
1000 * Create print file with the following options:
1100 *
1200 * CRTPRTF FILE(CET/EXMP1V4R2) PAGESIZE(66 85) +
1300 * SRCFILE(CET/DDSSRC) SRCMBR(*FILE) +
1400 * DEVTYPE(*AFPDS) USRDFNDTA('EDGESTITCH(*LEFT +
1500 * *DEVD 2 (*DEVD))')
1600 *
1700 **************************************************************
1800 *
1900 * set up the cover sheet with no data on it.
2000 *
2100 R RCD1 ENDPAGE
2200 DRAWER(7)
2300 FLD1 40A POSITION(1.0 1.0)
2400 *
2500 * Pull regular sheets from drawer 1
2600 *
2700 R RCD2 DRAWER(1)
2800 FLD2 40A 1SKIPB(5)

* * * * E N D O F S O U R C E * * * *

Figure 52. Edge-Stitched Document with Front Cover - DDS Source
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Edge-Stitched Document with Tabbed Inserts

Figure 54 shows a document that has tabs. The tabs are placed in the insert tray of the finisher.

This example selects the tabbed inserts from the insert tray (bin 7) and selects the document pages from
bin 1. The entire document is stapled on the left edge with three staples.

DDS Source

Use the DDS keyword DRAWER to select the appropriate input bin. Figure 55 on page 66 shows the DDS
source.

...

...

...
/********************************************************************/
/* Write a null string using RCD1. This will pull a sheet from the */
/* insert bin. In this case, the insert bin is bin 7. */
/* */
/********************************************************************/
PUT("",
"RCD1 ",fp);

/********************************************************************/
/* Write application data using RCD2. This pulls from bin 1. */
/********************************************************************/
PUT("This is a data page.",
"RCD2 ",fp);

Figure 53. Cover Sheet AS/400
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CTRTPRTF Command

Specify the EDGESTITCH parameter in the USRDFNDTA parameter.
CRTPRTF FILE(CET/EXMP1V4R2) PAGESIZE(66 85) +

SRCFILE(CET/DDSSRC) SRCMBR(*FILE) +
DEVTYPE(*AFPDS) +
USRDFNDTA('EDGESTITCH(*LEFT *DEVD 3 (*DEVD))')

Program Source

Figure 56 on page 67 shows the code fragment for tabbed inserts being pulled from bin 7 by using the
RCD1 record format. No data is written with this format; its purpose is to pull tabbed inserts. The
application data is written using the RCD2 record format, which pulls paper from bin 1.

5769PW1 V4R2M0 980228 SEU SOURCE LISTING 08/26/98 16:37:24
SOURCE FILE . . . . . . . CET/DDSSRC
MEMBER . . . . . . . . . EXMP1V4R2
SEQNBR*...+... 1 ...+... 2 ...+... 3 ...+... 4 ...+... 5 ...+... 6 ...+... 7 ...+... 8 ...+... 9 ...+... 0
100 **************************************************************
200 *
300 * Description: Print a finishing example using the DDS code
400 * to define the drawers to pull from. Bin 7 for a
500 * cover page and bin 1 for a regular sheet.
600 * The CRTPRTF command will include
700 * a parm to define the EDGESTITCH for the
800 * document.
900 *
1000 * Create print file with the following options:
1100 *
1200 * CRTPRTF FILE(CET/EXMP1V4R2) PAGESIZE(66 85) +
1300 * SRCFILE(CET/DDSSRC) SRCMBR(*FILE) +
1400 * DEVTYPE(*AFPDS) USRDFNDTA('EDGESTITCH(*LEFT +
1500 * *DEVD 3 (*DEVD))')
1600 *
1700 **************************************************************
1800 *
1900 * set up the cover sheet with no data on it.
2000 *
2100 R RCD1 ENDPAGE
2200 DRAWER(7)
2300 FLD1 40A POSITION(1.0 1.0)
2400 *
2500 * Pull regular sheets from drawer 1
2600 *
2700 R RCD2 DRAWER(1)
2800 FLD2 40A 1SKIPB(5)

* * * * E N D O F S O U R C E * * * *

Figure 55. Edge-Stitched Document with Tabbed Inserts, DDS Source
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Edge-Stitched Document with Z-Folded Sheets

Figure 57 shows a document that is stapled with z-folded sheets.

Z-fold is only supported using the form definition. This example shows how to use the INVMMAP DDS
keyword to switch between media maps (copy groups) within the form definition.

Form Definition Source

Use the form definition in “Edge-Stitched Document with Z-Folded Sheets” on page 91 to create the
F1FEZ010 form definition.

DDS Source

Figure 58 on page 68 shows the DDS source.

...

...

...
/********************************************************************/
/* Write a null string using RCD1. This will pull a tabbed insert */
/********************************************************************/
PUT("",

"RCD1 ",fp);
/********************************************************************/
/* Write application data using RCD2. This pulls from bin 1. */
/********************************************************************/
PUT("This is a data page.",
"RCD2 ",fp);

/********************************************************************/
/* Pull another tabbed insert. */
/********************************************************************/
PUT("",
"RCD1 ",fp);

/********************************************************************/
/* Write some more application data using RCD2. */
/********************************************************************/
PUT("This is another data page.",
"RCD2 ",fp);

Figure 56. Edge-Stitched Document with Tabbed Inserts, Program Source
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Figure 57. Edge-Stitched Document with Z-Folded Sheets
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CRTPRTF Command

Specify the CRTPRT command for the F1JOB003 form definition. Note also that the DRAWER and
DUPLEX parameters are set to *FORMDF:
CRTPRTF FILE(CET/EXMP3V4R2) PAGESIZE(66 85) +

SRCFILE(CET/DDSSRC) SRCMBR(*FILE) +
FORMDF(CET/F1FEZ010) DRAWER(*FORMDF) +
DUPLEX(*FORMDF) DEVTYPE(*AFPDS)

Program Source

Figure 59 on page 69 shows the code fragment from the application program writing data to Z-folded
sheets using record format RCD1 and writing data to regular sheets using record format RCD2.

5769PW1 V4R2M0 980228 SEU SOURCE LISTING 08/26/98 21:06:03
SOURCE FILE . . . . . . . CET/DDSSRC
MEMBER . . . . . . . . . EXMP3V4R2
SEQNBR*...+... 1 ...+... 2 ...+... 3 ...+... 4 ...+... 5 ...+... 6 ...+... 7 ...+... 8 ...+... 9 ...+... 0
100 **************************************************************
200 *
300 * Description: Print a finishing example using the formdef
400 * F1FEZ010 to define the copy groups for a ZFOLD
500 * page and regular pages.
600 *
700 * Copy group ZFOLDPGS will draw sheets from bin 3.
800 * Copy group DOCPAGES will draw sheets from bin 1.
900 *
1000 * Create printer file with the following options:
1100 *
1200 * CRTPRTF FILE(CET/EXMP3V4R2) PAGESIZE(66 85) +
1300 * SRCFILE(CET/DDSSRC) SRCMBR(*FILE) +
1400 * FORMDF(CET/F1FEZ010) DRAWER(*FORMDF) +
1500 * DUPLEX(*FORMDF) DEVTYPE(*AFPDS)
1600 *
1700 **************************************************************
1800 *
1900 * Invoke the copygroup to put out a ZFOLD sheet
2000 *
2100 R RCD1 ENDPAGE
2200 INVMMAP(ZFOLDPGS)
2300 FLD1 80A POSITION(1.0 1.0)
2400 *
2500 * Invoke the copygroup to put out regular sheets
2600 *
2700 R RCD2 ENDPAGE
2800 INVMMAP(DOCPAGES)
2900 FLD2 80A POSITION(1.0 1.0)

* * * * E N D O F S O U R C E * * * *

Figure 58. Edge-Stitched Document with Z-Folded Sheets, DDS Source
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Saddle-Stitched 2-UP Document

Figure 60 shows the document that uses A4 or ledger paper that is saddle-stitched.

This example uses only the printer file. It assumes that drawer two of the printer is loaded with ledger size
paper. This example will produce a 2-up duplex document that is saddle-stitched. The application
programmer is responsible for writing the data in the correct order. That is:

v 1st page encountered is the last document page

v 2nd page encountered is page 1 of the document

v 3rd page encountered is page 2 of the document

v 4th page encountered is the next to the last document page

v 5th page encountered is page 3rd from the last document page

v 6th page encountered is page 3 of the document

v 7th page encountered is page 4 of the document

v 8th page encountered is the 4th from the last document page

v And so forth in groups of four or less

DDS Source

This example does not use DDS.

CRTPRTF Command

Specify the following on the CRTPRTF command:
DEVTYPE(*AFPDS) MULTIUP(2) REDUCE(*NONE)
DUPLEX(*YES)
DRAWER(2)
USRDFNDTA('SADLSTITCH(*DEVD *DEVD (*DEVD))')

...

...
PUT("This is a Z-fold page, using copy group ZFOLDPGS",
"RCD1 ",fp);

PUT("This is a data page, using copy group DOCPAGES",
"RCD2 ",fp);

PUT("This is another Z-fold page, using copy group ZFOLDPGS",
"RCD1 ",fp);

PUT("This is a another data page, using copy group DOCPAGES",
"RCD2 ",fp);

Figure 59. Edge-Stitched Document with Z-Folded Sheets, Program Source Fragment
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Figure 60. Saddle-Stitched 2-UP Document
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Program Source

There is no unique program source for this example.

Note: The application programmer is responsible for writing the data in the correct order so that the
completed booklet reads correctly.
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Edge-Stitched on Right

Figure 61 shows a document that is stapled on the right.

This example uses only the printer file. It produces a document with edge stitching on the right.

DDS Source

This example does not use DDS.

CRTPRTF Command

Specify the following on the CRTPRTF command:
USRDFNDTA('EDGESTITCH(*RIGHT *DEVD 3 (*DEVD))')

Program Source

There is no unique program source for this example.
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Figure 61. Edge-Stitched on Right
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Top Left Corner Staple

Figure 62 shows the document with the top left corner stapled.

DDS Source

This example does not use DDS.

CRTPRTF Command

Specify the following on the CRTPRTF command:
USRDFNDTA('CORNERSTPL(*TOPLEFT)')

Program Source

There is no unique source for this example.
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Figure 62. Top Left Corner Staple
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Edge-Stitch 2 Left

Figure 63 shows a document that has two staples on the left side.

DDS Source

This example does not use DDS.

CRTPRTF Command

Specify the following on the CRTPRTF command:
USRDFNDTA('EDGESTITCH(*LEFT *DEVD 2 (*DEVD))')

Program Source

There is no unique program source for this example.
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Figure 63. Edge-Stitch 2 Left
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Z-Fold 2-UP Sheets

Figure 64 shows a z-folded document that has been printed 2-up.

DDS Source

Since all sheets are to be z-folded, the form definition does not contain multiple copy groups. This
eliminates the need to write any DDS to switch between copy groups.

CRTPRTF Command
CRTPRTF FILE(CET/EXMP8V4R2) PAGESIZE(66 85) +

FORMDF(CET/F1FZ0030) DRAWER(*FORMDF)+
DUPLEX(*FORMDF) DEVTYPE(*AFPDS)

Program Source

There is no unique program source for this example.
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Figure 64. Z-Fold 2-UP Sheets
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Chapter 5. Form Definition and PPFA

This chapter explains the basic terms of PPFA and contains examples using form definitions.

Be sure you have read “Chapter 1. InfoPrint 60 Finisher Introduction” on page 1 before you use this
chapter.

A form definition (FORMDEF) is the PSF resource that specifies the physical attributes of the printed
output. The word form refers to a sheet of paper or any other print medium.

You can specify a form definition with every print file that goes to an AFP printer. For information about
using form definitions in your environment see “Chapter 2. Printing with InfoPrint Manager” on page 13,
“Chapter 3. Printing with PSF/MVS” on page 49, or “Chapter 4. Printing with AS/400” on page 53.

For InfoPrint Manager PPFA can be installed on the MPC server at installation. Form definitions are
shipped with the InfoPrint Manager.

A form definition contains printing controls that specify these types of information:

v Page origin

v Medium overlays to be included

v Paper source (bin number)

v Number of copies of each page to be printed

v Simplex or duplex printing

v Page rotation

v Finishing information

PPFA (Page Printer Formatting Aid) is the IBM software product that builds form definitions in all
environments that support the finisher attachment. If you are already familiar with the use of PPFA, you
can skip to “New Form Definition Commands for Finishing” on page 82. The next sections explain PPFA
and familiarize you with some terms you need to know to create or modify form definitions.

Page Printer Formatting

Do these steps to use form definitions that PPFA creates:

1. Create the form definition source to position the data and define the processing.

Note: The correct paper must be installed in each bin used. If the paper size is not correct, the print
job may not print or you will not receive the correct output.

2. Run PPFA on the form definition to generate the objects you store in a library.

For additional information see:

v

http://www.printers.ibm.com --> Tech Support --> Manuals

v IBM Page Printer Formatting Aid: User’s Guide, S544-5284
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PPFA Concepts

The concepts of physical page and logical page are basic to understanding form-definition controls.

Physical Page

A physical page is the sheet of paper (form) or other medium (for example, a sheet of labels) that moves
through the printer.

Logical Page

A logical page is the area you define in a PPFA command stream as the space on the physical page
where data is printed. The logical page is positioned in relation to the media origin. For more information
about the media origin of your printer, see your printer documentation or the Advanced Function
Presentation: Printer Information, G544-3290. The positioning of the logical page on the sheet of paper is
described in “Positioning a Logical Page on a Sheet” on page 78.

PPFA Basic Terms

Direction

In PPFA, direction refers to the orientation of text in pages, printlines, and fields on a sheet of paper.
Direction is defined as the orientation of the text baseline direction relative to the origin of the physical
sheet of paper. The baseline is the imaginary line on which successive characters are aligned in a line of
text.

There are four logical text directions: ACROSS, DOWN, BACK, and UP relative to the media origin of the
sheet of paper. Baseline and inline direction are shown in Figure 65 on page 77. A print direction is a
combination of both inline and baseline directions. For each of the directions, characters can be printed in
four rotations.

The line direction is the direction in which successive characters are added to a line of text. The four line
directions are:

ACROSS

Text characters are placed in a line from left to right across the page.

DOWN

Text characters are placed in a line from top to bottom down the page.

BACK

Text characters are placed in a line from right to left across the page.

UP

Text characters are placed in a line from bottom to top up the page.

The baseline direction is the direction in which successive lines of text are added to a page. The four
character rotations, measured clockwise around each inline direction, for each line direction are:

0°

90°

180°

270°

For example, the text in this paragraph is printed ACROSS the page, and its character rotation is 0°.
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Figure 65 shows the four possible directions.

Presentation

Presentation describes the shape of the page as the reader views it. Portrait and Landscape Presentations
(Figure 66 on page 78) shows an example of how text is presented (positioned) on the page. The two
page presentations are:

Portrait
Designed to be viewed with the short side at the top of the page.

Landscape
Designed to be viewed with the long side at the top of the page.

This page is
printed in
the across
direction

T
his page is

printed in
the dow

n
direction

This page is
printed in
the back
direction

T
hi

s 
pa

ge
 is

pr
in

te
d 

in
th

e 
up

di
re

ct
io

n

Media
Origin

Media
Origin

0, 0

Media
Origin

0, 0
Media
Origin

0, 0

0, 0Inline  x

Inline  x

In
lin

e 
 x

In
lin

e 
 x

Baseline  y

B
as

el
in

e 
 y

B
as

el
in

e 
 y

Baseline   y

Inline Across
Baseline 0

Inline Back
Baseline 180

Inline Up
Baseline 270

Inline Down
Baseline 90

C
2P

I0
01

2

Figure 65. Baseline Direction and Inline Direction

Chapter 5. Form Definition and PPFA 77



N_UP Partitions

Some printers allow the physical sheet of paper to be divided into equal-sized partitions. For two or three
partitions, each sheet is divided along one or two lines equally spaced along the longer side of the sheet.
The printer will position a logical page of print data in each partition. This lets you print multiple logical
pages with different formats and modifications on a single sheet of paper.

The size and arrangement of the partitions on the sheet depends on the number of partitions and the
shape and size of the paper. For two or three partitions, each sheet is divided at two or three points
equally spaced along the longer side of the sheet. For four partitions, each sheet is equally divided both
vertically and horizontally.

Positioning a Logical Page on a Sheet

The example in this section shows how the OFFSET subcommand is used to position the logical page on
the physical sheet. A logical page is the area on a sheet of paper where all printing occurs. You establish
the logical page origin, the point nearest the media origin, with the OFFSET subcommand. The OFFSET
subcommand requires two coordinates and may have four. The first x and y coordinate defines the
position on the front of the sheet, and the second x and y coordinate defines the position on the back of
the sheet. A sample form definition that specifies the logical page position for a simplex sheet is:
FORMDEF ABCD

OFFSET 1 IN 1 IN ;

Note: The 1 IN 1 IN is an abbreviation for 1 INCH 1 INCH. PPFA supports a number of different units of
measurement formats.

The example places the logical page origin one inch to the right of and one inch down from the media
origin.

Origin of Logical Pages (Figure 67 on page 79), shows the meaning of the x and y coordinates. In writing
an OFFSET subcommand, the first parameter specifies x; the second parameter specifies y. If the x and y
are repeated for the offset of the back side of the physical page, the same applies. The x defines the
horizontal offset; the y defines the vertical offset. In this example, the logical text direction is ACROSS. The
arrows within the logical page indicate the inline direction for text on the page. The lines of text are added
according to the baseline direction.

Figure 66. Portrait and Landscape Presentations
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OFFSET Subcommand with Rotated Print Direction

Meaning of OFFSET (Figure 68) shows that the media origins and logical page origins do not change
when the print direction of the page changes, although the way you view the page does change. The
arrows within the logical page show the DOWN print direction-producing landscape page presentation.

Duplex Printing

Printing on both sides of a sheet (duplex printing) can be done in two ways: by the use of the FRONT and
BACK subcommand combination or by the use of the BOTH subcommand. If you select FRONT and
BACK, the number of copies requested for each must be the same.

Duplex Printing in Portrait and Landscape Presentations

Duplex printing with PPFA and PSF printers offers several other options. This example shows the
combination of portrait and landscape presentations with normal and tumble duplex printing:
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Figure 68. Meaning of OFFSET Parameters within a Landscape Page
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NORMAL and TUMBLE are parameters of a DUPLEX subcommand. For example, a form definition
specifying DUPLEX NORMAL could be written this way:
FORMDEF ABCD ;

COPYGROUP ABCD
DUPLEX NORMAL ;

SUBGROUP BOTH
COPIES 1 ;

Document A in Duplex Normal (Figure 69) shows the result of a DUPLEX NORMAL specification in the
portrait presentation. Document B shows the result of the same form definition when a landscape
presentation is specified. The printout in landscape presentation is really in a tumble-duplex format, having
the tops (of the front side) and the bottoms (of the back side) of the logical pages toward the same edge
of the sheet.

Although tumble duplex can be specified in this manner for landscape pages, another parameter,
RTUMBLE (rotated tumble), exists to make the form definition look more sensible for use in landscape
print jobs. It also produces the results shown in Figure 69, depending on whether the form definition called
for portrait or landscape presentation. For landscape, the form definition should be written as follows:
FORMDEF ABCD

PRESENT LANDSCAPE ;
COPYGROUP ABCD

DUPLEX RTUMBLE ;
SUBGROUP BOTH

COPIES 1 ;

The DUPLEX NORMAL and DUPLEX RTUMBLE controls actually produce the same result on the physical
page. RTUMBLE is used to maintain an association between duplex specifications and logical page print
direction. The same relationship exists between the RNORMAL and the TUMBLE parameters as exists
between the NORMAL and the RTUMBLE parameters; that is, within the two sets the terms are
interchangeable.

Figure 69. Duplex Normal: Portrait and Landscape Presentation
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For example, you could write a form definition using DUPLEX TUMBLE as follows:
FORMDEF DEFG ;
COPYGROUP DEFG

DUPLEX TUMBLE ;
SUBGROUP BOTH

COPIES 1 ;

Documents C and D in Result When Either TUMBLE or RNORMAL is Specified (Figure 70) are the results,
depending on how page definition direction is specified to achieve either a portrait page or a landscape
page.

Table 9. Duplex Specifications

If the form definition
duplex specification
is . . .

and if the page
definition direction
is . . .

the duplex
printing result
is . . .

DUPLEX NORMAL ACROSS or BACK normal duplex - portrait

DUPLEX RTUMBLE DOWN or UP tumble duplex - landscape

DUPLEX TUMBLE ACROSS or BACK tumble duplex - portrait

DUPLEX RNORMAL DOWN or UP normal duplex - landscape

Note: Other control combinations are not recommended.
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New Form Definition Commands for Finishing

These finishing operations are supported for the InfoPrint 60 finisher:

v On the FORMDEF command, these functions are allowed:

1. CORNER: one staple is driven into the media at the REFERENCE corner.

2. SADDLE: two staples are driven into the media along the finishing operation axis, which is
positioned in the center of the media parallel to the reference edge.

3. EDGE: two or three staples are driven into the media along the finishing operation axis.

v On the COPYGROUP command, these functions are allowed:

1. ZFOLD: causes the sheet to first be folded in half inward (the front side of the sheet is now inside
the fold) along a line parallel to the reference edge. The half of the sheet originally farthest from the
reference edge is again folded in half outward along a line parallel to the reference edge. For
example, when z-folding is applied to an 11 x 17 inch sheet with the reference edge along a short
side, the result is an 8.5 x 11 inch fold-out.

FINISH Subcommand Syntax

Only the new parameters on the FORMDEF that are valid for the InfoPrint 60 finisher are shown below.
For a complete description of the FORMDEF command, see the PPFA User’s Guide, S544-5284.

FORMDEF fname
...
FINISH

SCOPE { PRINTFILE | ALL | n }
OPERATION { CORNER | SADDLE | EDGE }

REFERENCE { DEFAULT | TOPLEFT | TOPRIGHT | BOTRIGHT | BOTLEFT |
TOP | BOTTOM | RIGHT | LEFT }

OPCOUNT n
... ;

Syntax Rules
v All subcommand fields are optional but, if coded, the parameters are required. (Finish subcommands

are: SCOPE, OPERATION, REFERENCE, and OPCOUNT. All other fields in the syntax diagram are
parameters.)

v Underlined fields are defaults.

v If REFERENCE is coded, OPERATION must also be coded and must precede it.

v CORNER requires a ″corner″ type REFERENCE (like TOPLEFT), while all other operations require an
″axis″ type REFERENCE (like TOP).

FINISH Subcommand Syntax with COPYGROUP Command
COPYGROUP cgname

...
FINISH OPERATION { ZFOLD }
... ;

Syntax Rules
v ZFOLD is the only operation allowed. The implied scope of the operation is medium, meaning the entire

copygroup.

v All subcommand fields are optional but, if coded, the parameters are required.

v Underlined fields are defaults.
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Keyword and Parameter Definitions

OPERATION Finishing operation type:

v CORNER: one staple is driven into the media at the reference corner. For
corner staples, the offset and angle of the staple from the selected corner is
device-dependent.

v SADDLE: two staples are driven into the media along the finishing operation
axis, which is positioned at the center of the media parallel to the reference
edge.

v EDGE: two or three staples are driven into the media along the finishing
operation axis.

v ZFOLD: a z-fold operation is applied to the media along the finishing
operation axis.

REFERENCE Finishing operation reference corner and edge:

v TOPLEFT: top-left corner (default for corner staple)

v BOTRIGHT: bottom-right corner

v TOPRIGHT: top-right corner

v BOTLEFT: bottom-left corner

v RIGHT: right edge

v LEFT: left edge (default for long-edge fed edge stitch)

v TOP: top edge (default for short-edge fed edge stitch)

v BOTTOM: bottom edge

v DEFAULT: device default edge or corner

OPCOUNT Number of staples to place if using EDGE finishing. Valid values are 0, 2, or 3.
The default is 0, which means to use the device default of 2 staples.
OPCOUNT is only valid with EDGE finishing.

SCOPE PRINTFILE means the specified finishing operations for this OPERATION
subcommand are applied to the complete print file, excluding header pages,
trailer pages, and message pages (print file consists of one or more
documents). ALL means the specified finishing operations are applied to each
documents individually (bounded by BDT/EDT) in the print file n means the
finishing operation is applied to a specific document. 1 means apply the
finishing operation to the 1st document in print file, 2 is the 2nd document, etc.
The range of values is 1-32767.

FORMDEF Using Finishing

Here are a few examples of using finishing in your FORMDEF. For a list of the form definitions IBM
supplies, see “Sample Form Definitions” on page 85.

v These examples are valid :
FINISH
FINISH SCOPE ALL
FINISH OPERATION CORNER
FINISH OPERATION CORNER REFERENCE TOPLEFT
FINISH SCOPE ALL OPERATION EDGE REFERENCE LEFT OPCOUNT 3
FINISH SCOPE 5

OPERATION CORNER
REFERENCE TOPLEFT

SCOPE 9
OPERATION EDGE

v These examples are not valid :

–
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FINISH OPERATION (requires parameter for OPERATION)
FINISH SCOPE (requires parameter for SCOPE)
FINISH SCOPE ALL (REFERENCE precedes OPERATION)

REFERENCE TOPLEFT
OPERATION CORNER

FINISH OPERATION EDGE (EDGE requires "axis" type REFERENCE,
REFERENCE TOPLEFT not a "corner" type)

Note:

1. FORMDEF Finishing notes:

a. Default SCOPE is PRINTFILE, default OPERATION is CORNER, and default
REFERENCE is DEFAULT.

b. For saddle stitch operation, the staples are placed along the center of the media parallel
to the reference edge.

c. The finishing operation must be specified at least once, and may occur more than once. It
specifies finishing operations to be applied to the collected media. If more than one
finishing operation is specified, the operations are applied in the order in which they are
specified.

You cannot z-fold after stapling or saddle stitch after folding.

d. For finishing, the top left corner is defined to be the default media origin. Changing the
orientation of the medium presentation space does not change the finishing corners or
edges. FINISH positions are not affected by DIRECTION or PRESENT values.

2. COPYGROUP Finishing notes:

a. The default OPERATION is ZFOLD and the default REFERENCE is DEFAULT.

b. The finishing OPERATION subcommand may be specified only once on a COPYGROUP.

c. For the finishing operation, changing the orientation of the medium presentation space
does not change the finishing position. For instance, the finishing reference edge (corner)
is not affected by DIRECTION or PRESENT values.

d. FINISH on the COPYGROUP command (for example, ZFOLD) is not supported on the
AS/400 system.

Messages with Finisher
v AKQ258W

AKQ258W MORE THAN 122 OPERATION POSITIONS
SPECIFIED FOR A FINISH OPERATION.

Explanation: More than 122 operation
finishing positions are specified.

System Action: Formdef will be generated with 122 operation
finishing positions. All others will be ignored.

User Response: Move extraneous operator position values.

v AKQ260E
AKQ260E CORNER NOT ALLOWED ON COPYGROUP
AKQ260E ZFOLD NOT ALLOWED ON FORMDEF

The following code:
FINISH OPERATION EDGE REFERENCE TOPLEFT

Yields this message:
AKQ260E TOPLEFT NOT ALLOWED ON This OPERATION

Because the operation "EDGE" needs an "axis" type
reference ("LEFT" for example).

Explanation: An invalid combination of subcommands and parameters
is used on the FINISH subcommand or the incorrect FINISH OPERATION
is used on the FORMDEF or COPYGROUP command. For example - The ZFOLD
Operation is only valid on the COPYGROUP command. It is not valid in
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a FORMDEF command.

System Action: A formdef is not generated. The syntax check continues
from a valid command.

User Response: Use the correct combination of commands and finishing
subcommands and parameters.

Sample Form Definitions

IBM supplies form definitions with PSF that you can use as-is or that you can modify using PPFA to suit
your environment. The naming conventions for the form definitions are:

You can obtain additional form definitions designed specifically for the InfoPrint 60 finisher from:
ftp.software.ibm.com/printers

The additional form definitions IBM supplies for the InfoPrint 60 finisher are:
F1FC0010 top left corner, bin 1, no duplex
F1FC0011 top left corner, bin 1, normal duplex
F1FC0012 top left corner, bin 1, tumble duplex
F1FE0010 left edge, bin 1, no duplex
F1FE0011 left edge, bin 1, normal duplex
F1FE0012 left edge, bin 1, tumble duplex
F1FS0010 saddle, bin 1, no duplex
F1FS0011 saddle, bin 1, normal duplex

F _1_ ___ ___ _0_ ___ ___ ___
| | | | | | | |
| | | | | | |---|-------- LA - Landscape Across
| | | | | | | | LD - Landscape Down
| | | | | | | | PA - Portrait Across
| | | | | | | | PD - Portrait Down
| | | | | | | |
| | | | | | | |-------- Duplex indication
| | | | | | | 0 - None (Simplex)
| | | | | | | 1 - Normal (Duplex)
| | | | | | | 2 - Tumble (Duplex)
| | | | | | |
| | | | | | |------------ E - Envelope
| | | | | | # - Output Bin number
| | | | | | M - Manual
| | | | | |
| | | | |---|---------------- 00 - Offset 0,0
| | | | 01 - Offset 0.0165,0.0165
| | | |
| | |---|------------------------ A1 or A0: for all AFP printers other than the 3800
| | CP for use with HP printers (PCL4, PCL5) through PSF/2
| | C1 or 01: 3800 compatibility
| | H1 - 3-Hole punched paper
| | FC - Finisher with corner staple
| | FE - Finisher with edge stitch
| | FS - Finisher with saddle stitch
| | FZ - Finisher with z-fold
| | N2 - N_up (2 up)
| |
|--|-------------------------------- Always F1

F - FORMDEF
1 - Single copy

Figure 71. Form Definition Layout
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F1FZ0030 z-fold from bin 3
F1FS2031 saddle stitch 2 up
F1FEC010 left edge stitch, cover sheet from bin 7
F1FEL010 2 left edge staples
F1FER010 3 right edge staples
F1FEZ010 edge stitch with z-fold sheets from bin 3
F1FZ1021 z-fold ledger 1 up landscape
F1FZ2021 z-fold ledger 2 up portrait

Finishing Examples

This section contains examples that show you how to use a printer file and form definitions to perform
various finishing operations.
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Edge-Stitched Document with Front Cover

This example shows a cover page that is placed in the finisher insert or input tray and the document from
the printer being stapled.

The PPFA source code for the form definition follows:

Instructions:

1. Submit the PPFA source code as shown above to create a formdef using PPFA or use the form
definition object supplied with PSF.

2. To instruct the printer to pull the cover sheet from the finisher inserter tray (bin 7) and to pull the
document pages from the printer main input tray (bin 1), you need to change copy groups in the AFP
document that you are printing. Changing copy groups depends on how your document is produced:

v For a SCRIPT document, use the .CG control word to select a different copy group for the first page
and subsequent pages in the document:

– .CG COVERPAG (this pulls a cover sheet from bin 7)

– .CG DOCPAGES (this pulls the document sheets from bin 1)

v For an AFP Toolbox application, use the Invoke Medium Map command:

– AFPInvokeMediumMap(Page1,″COVERPAG″);

– AFPInvokeMediumMap(Page2,″DOCPAGES″);

v If you are using a page definition, you can switch copy groups using the CONDITION command:
PAGEDEF JOB001
PAGEFORMAT FIRST;
PRINTLINE CHANNEL 1

POSITION MARGIN TOP;
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Figure 72. Edge-Stitched Document with Front Cover

-------------------------------------------------
-------------------------------------------------
FORMDEF FEC010 REPLACE YES

FINISH SCOPE ALL
OPERATION EDGE REFERENCE LEFT OPCOUNT 2;

/******************************************************/
COPYGROUP COVERPAG
DUPLEX NO
CONSTANT FRONT
BIN 7;

COPYGROUP DOCPAGES
BIN 1;

-------------------------------------------------
-------------------------------------------------
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CONDITION CVRSHEET START 1 LENGTH 1
WHEN GE X"00" AFTER SUBPAGE
COPYGROUP COVERPAG PAGEFORMAT REST;

PAGEFORMAT REST;
PRINTLINE CHANNEL 1

POSITION MARGIN TOP
REPEAT 60;

v If you have a line data or AFP file, you can modify it to insert IMM structured fields between pages
(in hex):

IMM COVERPAG would be 5A0010D3ABCC000000C3D6E5C5D9D7C1C7
IMM DOCPAGES would be 5A0010D3ABCC000000C4D6C3D7C1C7C5E2

3. Prepare the finisher by installing the required media for the cover sheet in the finisher insert tray. It has
to be the same size as the media in insert tray (in this case, 8.5 x 11 inch media was used for both).

4. Submit the print job. The result is a cover sheet and document that is stitched along the left edge with
2 staples.
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Edge-Stitched Document with Tabbed Inserts

The PPFA source code for the form definition follows:

Instructions:

1. Submit the PPFA source code as shown above to create a formdef using PPFA or use the form
definition object supplied with PSF.

2. In order to instruct the printer to pull the cover sheet from the finisher inserter tray (bin 7) and to pull
the document pages from the printer main input tray (bin 1), you need to change copy groups in the
AFP document that you are printing. Changing copy groups depends on how your document is
produced:

v For a SCRIPT document, use the .CG control word to select a different copy group for the first page
and subsequent pages in the document:

– .CG COVERPAG (this pulls a cover sheet from bin 7)

– .CG DOCPAGES (this pulls the document sheets from bin 1)

v For an AFP Toolbox application, use the Invoke Medium Map command:

– AFPInvokeMediumMap(Page1,″COVERPAG″);

– AFPInvokeMediumMap(Page2,″DOCPAGES″);

v If you are using a page definition, you can switch copy groups using the CONDITION command:
PAGEDEF JOB001
PAGEFORMAT FIRST;
PRINTLINE CHANNEL 1
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Figure 73. Edge-Stitched Document with Tabbed Inserts

-------------------------------------------------
-------------------------------------------------
FORMDEF FEC010 REPLACE YES

FINISH SCOPE ALL
OPERATION EDGE REFERENCE LEFT OPCOUNT 2;

/******************************************************/
COPYGROUP COVERPAG
DUPLEX NO
CONSTANT FRONT
BIN 7;

COPYGROUP DOCPAGES
BIN 1;

-------------------------------------------------
-------------------------------------------------
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POSITION MARGIN TOP;
CONDITION CVRSHEET START 1 LENGTH 1

WHEN GE X"00" AFTER SUBPAGE
COPYGROUP COVERPAG PAGEFORMAT REST;

PAGEFORMAT REST;
PRINTLINE CHANNEL 1

POSITION MARGIN TOP
REPEAT 60;

v If you have a line data or AFP file, you can modify it to insert IMM structured fields between pages
(in hex):

IMM COVERPAG would be 5A0010D3ABCC000000C3D6E5C5D9D7C1C7
IMM DOCPAGES would be 5A0010D3ABCC000000C4D6C3D7C1C7C5E2

3. This process of inserting two IMM structured fields into the file to be printed must be repeated prior to
every page that is to be preceded with an inserted tab form.

4. Prepare the finisher by installing the tab forms (tabs on the trailing edge) into the finisher insert tray. If
pre-printed tabs are used, the printed side is placed face up with the tabs upside down (top edge
toward the front of the finisher) and in the correct order (first on top, second one below that and so
forth). The printed pages are pulled from the insert tray, so the insert tray must be loaded with letter
size media.

5. Submit the print job. The result is a document that consists of a tab sheet followed by printed sheets
and so on for as many tabs and printed pages as the file calls for.
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Edge-Stitched Document with Z-Folded Sheets

The PPFA source code for the form definition follows:

Instructions:

1. Submit the PPFA source code as shown above to create a formdef using PPFA or use the form
definition object supplied with PSF.

2. In order to instruct the printer to pull the z-fold from the printer bin 3 (upper sub tray) and to pull the
document pages form the printer main input tray (bin 1), you need to change copy groups in the AFP
document that you are printing. Changing copy groups depends on how your document is produced:

v For a SCRIPT document, use the .CG control word to select a different copy group for the first page
and subsequent pages in the document:

– .CG ZFOLDPGS (this pulls a ledger sheet from bin 3 for z-folding)

– .CG DOCPAGES (this pulls the current sheet and subsequent sheets from bin 1)

v For an AFP Toolbox application, use the Invoke Medium Map command:

– AFPInvokeMediumMap(Page1,″ZFOLDPGS″);

– AFPInvokeMediumMap(Page2,″DOCPAGES″);

v If you are using a page definition, you can switch copy groups using the CONDITION command:
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Figure 74. Edge-Stitched Document with Z-Folded Sheets

-------------------------------------------------
-------------------------------------------------
FORMDEF FEZ010 REPLACE YES

FINISH SCOPE ALL
OPERATION EDGE REFERENCE LEFT OPCOUNT 2;

/******************************************************/
COPYGROUP ZFOLDPGS
DUPLEX NO
BIN 3
FINISH OPERATION ZFOLD
N_UP 1
PLACE 1 FRONT OFFSET 17 IN 11 IN ROTATION 180
PRESENT LANDSCAPE DIRECTION ACROSS;

COPYGROUP DOCPAGES
BIN 1;

-------------------------------------------------
-------------------------------------------------
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PAGEDEF JOB002
PAGEFORMAT FIRST;
PRINTLINE CHANNEL 1

POSITION MARGIN TOP;
CONDITION ZFOLDPGS START 1 LENGTH 1

WHEN GE X"00" AFTER SUBPAGE
COPYGROUP ZFOLDPGS PAGEFORMAT REST;

PAGEFORMAT REST;
PRINTLINE CHANNEL 1

POSITION MARGIN TOP
REPEAT 60 ;

v If you have a line data or AFP file, you can modify it to insert IMM structured fields between pages
(in hex):

IMM ZFOLDPGS would be 5A0010D3ABCC000000E9C6D6D3C4D7C7E2
IMM DOCPAGES would be 5A0010D3ABCC000000C4D6C3D7C1C7C5E2

3. Prepare the printer by installing ledger media into the printer bin 3 (upper sub-tray) and letter media
into the printer bin 1 (main tray).

4. Submit the print job. The result should be document that consists of a z-folded page followed by
unfolded pages followed by another z-folded page, etc., for the number of pages called for by the
document. The printed document is edge-stitched along the left edge with two staples.
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Saddle-Stitched 2-UP Document

The PPFA source code for the form definition follows:

Instructions:

1. Submit the PPFA source code as shown above to create a formdef using PPFA or use the form
definition object supplied with PSF.

2. Modify or create the file that is to be printed and saddle stitched to reorder the pages like this:

v 1st page encountered is the last document page

v 2nd page encountered is page 1 of the document

v 3rd page encountered is page 2 of the document

v 4th page encountered is the next to the last document page

v 5th page encountered is page 3rd from the last document page

v 6th page encountered is page 3 of the document

v 7th page encountered is page 4 of the document

v 8th page encountered is the 4th from the last document page

v And so forth in groups of four or less

3. Load ledger size paper into bin 3.

4. Submit the print job. The result is a saddle stitched document comprised of ledger sheets folded to
letter size and pre-printed back and front so as to contain the document pages in order.
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Figure 75. Saddle-Stitched 2-UP Document

-------------------------------------------------
-------------------------------------------------
FORMDEF FS2031 REPLACE YES

FINISH SCOPE ALL
OPERATION SADDLE
DUPLEX NORMAL
BIN 3
N_UP 2;

-------------------------------------------------
-------------------------------------------------
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Edge-Stitched on Right

The PPFA source code for the form definition follows:

Instructions:

1. Submit the PPFA source code as shown above to create a formdef using PPFA or use the form
definition object supplied with PSF.

2. Submit the print job. The result is a simplex document printed on media pulled from the printer default
input in and stitched along the right edge with three staples.

Staples
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Figure 76. Edge-Stitched on Right

-------------------------------------------------
-------------------------------------------------
FORMDEF FER010 REPLACE YES

FINISH SCOPE ALL
OPERATION EDGE REFERENCE RIGHT OPCOUNT 3;

-------------------------------------------------
-------------------------------------------------
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Top Left Corner Staple

The PPFA source code for the form definition follows:

Instructions:

1. Submit the PPFA source code as shown above to create a formdef using PPFA or use the form
definition object supplied with PSF.

2. Submit the print job. The result is a simplex document printed on media pulled from the printer default
input bin and stapled at the top left corner.
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Figure 77. Top Left Corner Staple

-------------------------------------------------
-------------------------------------------------
FORMDEF FC0010 REPLACE YES

FINISH SCOPE ALL
OPERATION CORNER;

-------------------------------------------------
-------------------------------------------------
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Edge-Stitched 2 Left

The PPFA source code for the form definition follows:

Instructions:

1. Submit the PPFA source code as shown above to create a formdef using PPFA or use the form
definition object supplied with PSF.

2. In this example, the media is letter size and the operator places letter size paper into bin 1 (main tray)
of the InfoPrint 60.

3. Make sure the finisher is enabled and submit the print job to the InfoPrint 60 using the formdef just
created.

4. The output is a simplex document, edge-stitched along the left edge of the media with 2 staples.
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Figure 78. Edge-Stitched 2 Left

-------------------------------------------------
-------------------------------------------------
FORMDEF FEL010 REPLACE YES

FINISH SCOPE ALL
OPERATION EDGE OPCOUNT 2;

-------------------------------------------------
-------------------------------------------------
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Z-Fold 2-UP Sheets

The PPFA source code for the form definition follows:

Instructions:

1. Submit the PPFA source code as shown above to create a formdef using PPFA or use the form
definition object supplied with PSF.

2. In this example, the customer’s file consists of letter size documents that are to be printed side by side
on ledger media (11 x 17 in) in simplex mode. Place ledger media in bin 3 of the InfoPrint 60.

3. Make sure the finisher is enabled and submit the print job to the InfoPrint 60.

4. The result is ledger size sheets z-folded to letter size with two letter size documents printed side by
side on one side only of the sheet.
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Figure 79. Z-Fold

-------------------------------------------------
-------------------------------------------------
FORMDEF FZ0030 REPLACE YES ;

COPYGROUP ZFOLDPGS
DUPLEX NO
BIN 3
FINISH OPERATION ZFOLD
N_UP 2
PLACE 1 FRONT OFFSET 17 IN 11 IN ROTATION 180
PLACE 1 FRONT OFFSET 8.5 IN 11 IN ROTATION 180
PRESENT PORTRAIT DIRECTION ACROSS;

-------------------------------------------------
-------------------------------------------------
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Z-Fold Landscape on Ledger, 1-UP

This example produces a mixture of letter pages from bin 1 and ledger paper from Bin 2, printed
landscape 1-UP. For example, you might be printing a financial report with a spreadsheet inserted.

FORMDEF FZ1021
OFFSET 0.0 IN 0.0 IN
FINISH SCOPE PRINTFILE
OPERATION EDGE
REFERENCE DEFAULT
REPLACE YES ;

COPYGROUP B02ZDN1R /* BIN 2 LEDGER: DUPLEX Z-FOLD */
DUPLEX NORMAL /* LANDSCAPE - N_UP 1 ROTATE TO PRINT UPRIGHT*/
BIN 2
OFFSET 0 IN 0 IN
FINISH OPERATION ZFOLD
PRESENT LANDSCAPE DIRECTION ACROSS
N_UP 1
PLACE 1 FRONT OFFSET 17 IN 11 IN ROTATION 180
PLACE 1 BACK OFFSET 17 IN 11 IN ROTATION 180 ;

COPYGROUP B01NF /* BIN 1 LETTER: DUPLEX NO FINISHING */
DUPLEX NORMAL
BIN 1
OFFSET 0 IN 0 IN
PRESENT PORTRAIT DIRECTION ACROSS ;

Instructions:

1. Submit the PPFA source code as shown above to create a formdef using PPFA or use the form
definition object supplied with PSF.

2. Load letter paper in bin 1 and ledger in bin 2 of the InfoPrint 60 printer.

3. Create a print file that uses copy group B01INF for the letter pages and B02ZDN1R for the ledger
pages.

4. Submit to print.
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Figure 80. Z-Fold Landscape on Ledger, 1-UP
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Z-Fold Portrait on Ledger Paper, 2-UP

This example produces a mixture of letter pages from bin 1 and ledger paper from bin 2. The ledger pages
are printed 2-UP, duplexed and z-folded.

FORMDEF FZ2021
DUPLEX NORMAL
OFFSET 0.0 IN 0.0 IN
FINISH SCOPE PRINTFILE
OPERATION EDGE
REFERENCE DEFAULT
REPLACE YES ;

COPYGROUP B02ZDN2R /* BIN 2 LEDGER: DUPLEX Z-FOLD */
DUPLEX NORMAL /* N_UP 2 ROTATED TO PRINT UPRIGHT*/
BIN 2
OFFSET 0 IN 0 IN
FINISH OPERATION ZFOLD
PRESENT PORTRAIT DIRECTION ACROSS
N_UP 2
PLACE 2 FRONT OFFSET 8.5 IN 11 IN ROTATION 180
PLACE 1 BACK OFFSET 8.5 IN 11 IN ROTATION 180
PLACE 1 FRONT OFFSET 8.5 IN 11 IN ROTATION 180
PLACE 2 BACK OFFSET 8.5 IN 11 IN ROTATION 180

INVOKE FRONT ;

COPYGROUP B01NF /* BIN 1 LETTER: DUPLEX NO FINISHING */
PRESENT PORTRAIT
DIRECTION ACROSS
DUPLEX NORMAL
BIN 1
OFFSET 0 IN 0 IN ;

Instructions:

1. Submit the PPFA source code as shown above to create a formdef using PPFA or use the form
definition object supplied with PSF.

2. Load letter paper in bin 1 and ledger in bin 2 of the InfoPrint 60 printer.

3. Create a print file that uses copy group B01INF for the letter pages and B02ZDN2R for the ledger
pages.

4. Submit to print.
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Figure 81. Z-Fold Portrait on Ledger Paper, 2-UP
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Complex Form Definition Example

This example shows a form definition and page definition, that is used to create a sample document using
tabs, edge stapling, and z-folded paper. The tabs are assumed to be loaded in the insert tray. Most of the
input paper is letter size, portrait, and duplexed. The z-fold page is ledger sized, printed rotated, and
simplexed.

1. Submit the PPFA source code as shown to create a form definition and page definition.

2. Load cover pages in bin 2, letter size paper in bin 1, ledger size paper in bin 3, pre-printed forms in bin
4, and pre-printed tab stock in bin 7.

3. Adjust the finisher for z-folding of ledger paper.

4. Create a data file similar to Figure 85 on page 103, that selects various types of pages.

5. Submit the job to print.

Form Definition Source

The form definition source is:
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Figure 82. Complex Form Definition Example
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Page Definition for Formatted Data Records

The page definition for formatted data records is:

SETUNITS 1 IN 1 IN ;

FORMDEF FN0001 OFFSET 0 0 REPLACE YES
FINISH SCOPE PRINTFILE
OPERATION EDGE REFERENCE LEFT OPCOUNT 3 ;

COPYGROUP F2COVER /* COVER PAGE FROM BIN 2 */
DUPLEX NO
BIN 2 ;
OVERLAY FNLOGO ;
SUBGROUP COPIES 1 OVERLAY FNLOGO;

COPYGROUP F2REPORT /* REPORT PAGES FROM BIN 1 */
DUPLEX NORMAL
BIN 1 ;
SUBGROUP COPIES 1;

COPYGROUP F2ZFOLD /* Z-FOLD 11X17 FROM BIN 3 */
DUPLEX NO
BIN 3
FINISH OPERATION ZFOLD
N_UP 1 OVERLAY FNMAPA
PRESENT LANDSCAPE DIRECTION ACROSS ;

COPYGROUP F2FORM /* PRE-PRINTED FORM FROM AUX BIN */
DUPLEX NORMAL
BIN 4 ;
SUBGROUP BOTH COPIES 1 ;

COPYGROUP F2INSERT /* INDEX TAB FROM INSERTER BIN */
DUPLEX NO
BIN 7 ;
SUBGROUP COPIES 1;

Figure 83. Form Definition Source
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Data Record Sample

A sample of the data records is:

SETUNITS 1 IN 1 IN LINESP 6 LPI ;
PAGEDEF FN0001 REPLACE YES WIDTH 8.5 HEIGHT 11 ;
FONT FTXT CS 4200 CP V10500 HEIGHT 10 ;
/* COURIER 10 PT OUTLINE CHARACTER SET AND CODE PAGE */
FONT FHDR1 CS N200 CP V10500 HEIGHT 20 RATIO 120 ;
/* TIMES NEW ROMAN 20 PT OUTLINE WIDTH EXPANDED 120% */
FONT FHDR2 CS N200 CP V10500 HEIGHT 16 ;
/* TIMES NEW ROMAN 16 PT OUTLINE FONT */

PAGEFORMAT P2REPORT WIDTH 8.5 HEIGHT 11 ;
PRINTLINE CHANNEL 1 REPEAT 1 POSITION 0.5 0.5 FONT FTXT ;
CONDITION CNCOVER START 1 LENGTH 10

WHEN EQ '**COVER***' BEFORE SUBPAGE
COPYGROUP F2COVER PAGEFORMAT P2COVER ;

CONDITION CNZFOLD START 1 LENGTH 10
WHEN EQ '**ZFOLD***' BEFORE SUBPAGE
COPYGROUP F2ZFOLD PAGEFORMAT P2ZFOLD ;

CONDITION CNINSERT START 1 LENGTH 10
WHEN EQ '**INSERT**' BEFORE SUBPAGE
COPYGROUP F2INSERT PAGEFORMAT P2INSERT ;

CONDITION CNFORM START 1 LENGTH 10
WHEN EQ '**FORM****' BEFORE SUBPAGE
COPYGROUP F2FORM PAGEFORMAT P2FORM ;

PRINTLINE REPEAT 59 POSITION 0.5 NEXT FONT FTXT ;
PAGEFORMAT P2COVER WIDTH 8.5 HEIGHT 11 ;
PRINTLINE CHANNEL 1 REPEAT 1 POSITION 0 0 ;
FIELD START 11 LENGTH 30 FONT FHDR1 POSITION 1 0.5 ;
FIELD START 41 LENGTH 30 FONT FHDR2 POSITION 1 2.5 ;
CONDITION CNREPORT START 1 LENGTH 1

WHEN GE X'00' AFTER SUBPAGE
COPYGROUP F2REPORT PAGEFORMAT P2REPORT ;

PAGEFORMAT P2ZFOLD WIDTH 17 HEIGHT 11 ;
PRINTLINE CHANNEL 1 REPEAT 1 POSITION 0.5 0.5 FONT FHDR1 ;
CONDITION CNREPORT ;

PAGEFORMAT P2FORM WIDTH 8.5 HEIGHT 11 ;
PRINTLINE CHANNEL 1 REPEAT 40 POSITION 1 2.0 FONT FTXT ;
FIELD START 11 LENGTH 10 POSITION * * ;
FIELD START 21 LENGTH 40 POSITION 3 * ;
CONDITION CNFORMF START 1 LENGTH 1

WHEN GE X'00' AFTER SUBPAGE
NULL PAGEFORMAT P2FORMB ;

PAGEFORMAT P2FORMB WIDTH 8.5 HEIGHT 11 ;
PRINTLINE CHANNEL 1 REPEAT 40 POSITION 0.5 2.0 FONT FTXT ;
FIELD START 11 LENGTH 10 POSITION * * ;
FIELD START 21 LENGTH 40 POSITION 3 * ;
CONDITION CNREPORT ;

PAGEFORMAT P2INSERT WIDTH 8.5 HEIGHT 11 ;
PRINTLINE CHANNEL 1 REPEAT 1 POSITION 0.5 0.5 ;
CONDITION CNREPORT ;

Figure 84. Page Definition for Formatted Data Records
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1**COVER***MAIN TITLE OF REPORT Sub Title of Report
1 List of Reports x(standard report format )xxxxxxxxxxxxxxxxx
List of Reports xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
List of Reports xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
List of Reports xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
List of Reports xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

1**FORM****AAAAAAAAAAaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa
**FORM****AAAAAAAAAAaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa
**FORM****AAAAAAAAAAaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa
**FORM****AAAAAAAAAAaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa
**FORM****AAAAAAAAAAaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa
**FORM****AAAAAAAAAAaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa
**FORM****AAAAAAAAAAaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaaa
1**FORM****BBBBBBBBBBbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbb
**FORM****BBBBBBBBBBbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbb
**FORM****BBBBBBBBBBbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbb
**FORM****BBBBBBBBBBbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbbb
1**INSERT** INSERT TAB
1Report Record xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
Report Record xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
1**INSERT** INSERT TAB
1Report Record xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
Report Record xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
1**ZFOLD***THIS IS A ZFOLD PAGE
1**COVER***

Figure 85. Data Record Sample
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Appendix. Paper Path

The sheet position in an input tray, the sheet size, simplex or duplex operation, input tray selection, and
finisher selection determines how the media moves through the printer and finisher. The following sections
describe the paper path and sheet orientation during printing and finishing.

Simplex, Bin, and Finisher

Figure 86 shows the placement of a pre-printed sheet «1¬ in bin 1, 2, or 3 in the printer. The sheet is
pre-printed on the front and is three-hole punched. The sheet is placed face down with the top edge to the
front. The sheet is long-edge fed.

The sheet is pulled from the bin «1¬, and turned over «2¬ for printing on the front side. The drum puts the
toner on the sheet, and the fuser fuses the toner to the paper. The sheet continues its path into the printer

Figure 86. Simplex, Bin, and Finisher
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output tray «3¬. The rollers push the sheet up into the output tray and then pull the sheet down into the
finisher «F¬ → «4¬. The sheet is turned over when it goes from position «3¬ in the printer output tray to the
finisher «4¬.

The sheets are held in the Output Holding tray «5¬ for a corner staple, two staples, or three staples,
depending on the finishing instructions. After stapling, the document is placed in the finisher’s output tray
«6¬.

Simplex, Side Tray, and Finisher

Figure 87 shows the placement of a pre-printed sheet «1¬ in the side tray that is attached to the printer.
The sheet is pre-printed on the front and is three-hole punched. With pre-printed information on the sheet,
the sheet is placed face up with the top edge to the front. The sheet is long-edge fed.

The sheet is pulled from the side tray «1¬ and passed to the drum «2¬ for printing on the front side. The
drum puts the toner on the paper and the fuser fuses the toner to the paper. The sheet continues its path
into the output tray «3¬. The rollers push the sheet up into the printer output tray and then pull the sheet
down into the finisher «F¬ → «4¬. The sheet is turned over when it goes from position «3¬ in the printer
output tray to the finisher «4¬.

Figure 87. Simplex, Side Tray, and Finisher
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The sheet can be held in the Output Holding tray «5¬ for a corner staple, two staples, or three staples
depending on the finishing instructions. After stapling, the document is placed in the finisher’s output tray
«6¬.

Duplex, Bin, and Finisher

Figure 88 on page 108 shows the placement of the pre-printed sheet «1¬ in bin 1, 2, or 3 in the printer.
The sheet is pre-printed on the front and is three-hole punched. The sheet is placed face up with the top
edge to the front. The sheet is long-edge fed.
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The sheet is pulled from the tray «1¬ and turned over «2¬ for printing on the back side. The drum puts the
toner on the paper, and the fuser fuses the toner to the paper. The sheet continues its path into the printer
output tray «3¬. The rollers push the sheet up into the printer output tray, and then pull the sheet down into
the printer «1A¬. The sheet is turned over «2A¬ for the front side to be printed. The drum puts the toner on
the paper, and the fuser fuses the toner to the paper. The sheet continues its path into the printer output
tray «3A¬. The rollers push the sheet up into the printer output tray and then pulls the sheet down into the
finisher «F¬ → «4¬. The sheet is turned over when it goes from position «3A¬ in the printer output tray to the
finisher «4¬.

Figure 88. Duplex, Bin, and Finisher
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The sheet can be held in the Output Holding tray «5¬ for a corner staple, two staples, or three staples
depending on the finishing instructions. After stapling, the document is placed in the finisher’s output tray
«6¬.

Duplex, Side Tray, and Finisher

Figure 89 shows the placement of the pre-printed sheet «1¬ in the side tray that is attached to the printer.
The sheet is pre-printed on the front and is three-hole punched. With pre-printed information, the sheet is
placed in the side tray front side down with the top of sheet to the front. The sheet is long-edge fed.

Figure 89. Duplex, Side Tray and Finisher
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The sheet is pulled from the side tray «1¬ and is sent to the printer for printing on the back side «2¬. The
drum puts the toner on the paper, and the fuser fuses the toner to the paper. The sheet continues its path
into the printer output tray «3¬. The rollers push the sheet up into the printer output tray and then pull the
sheet down into the printer «1A¬. The sheet is turned over and positioned for the front side to be printed
«2A¬. The drum puts the toner on the paper and the fuser fuses the toner to the paper. The sheet
continues its path into the printer output tray «3A¬. The rollers push the sheet up into the printer output tray
and then pulls the sheet down into the finisher «F¬ → «4¬. When the rollers push the sheet up into the
printer output tray and then sends the sheet to the finisher, the sheet is turned over.

The sheet can be held in the Output Holding tray «5¬ for a corner staple, two staples, or three staples
depending on the finishing instructions. After stapling, the document is placed in the finisher’s output tray
«6¬.

Finisher Saddle-Stitch

In Figure 90 on page 111, the sheet is received from the printer. Notice the short side of the sheet is
received into the holding bin «1¬. The holding bin stores all the sheets that make up the document. When
all the sheets are in the holding bin, they are stapled «2¬. After the sheets are stapled, the sheets move
downward into the prefold position «3¬. The set is then folded on the stapled center line and delivered to
the saddle stitch drawer «4¬.
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Simplex, Bin, and Finisher Z-Fold

The z-fold folds a larger sheet size to a common size. For example, ledger to letter or A3 to A4.

Figure 91 on page 112 shows the sheet «1¬ in the tray as a pre-printed sheet. The pre-printed sheet is
face down (the text IBM is blocked) with the top to the left. The sheet travels from the tray «1¬ to the drum
causing the sheet to be turned face up «2¬. The drum prints the front side and the sheet advances to
position «3¬.

When the sheet enters the finisher, it advances to a stop at position «4¬. At position «4¬ the back part of
the sheet is sucked between two rollers causing a fold in the sheet. The sheet travels to position «5¬
where the back part of the sheet is pulled between two rollers causing the second fold. After the second
fold, the sheet is placed in the output holding tray «6¬. The sheet can be stapled with other z-folded sheets
or other sheets in the output holding tray. The sheets are placed in the finisher’s output tray «7¬.

Figure 90. Saddle-Stitch
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Duplex, Bin, and Finisher Z-Fold

The z-fold reduces a larger sheet size to a common size. For example ledger to letter and A3 to A4.

Figure 92 on page 113 shows the sheet «1¬ in the printer input tray. The pre-printed sheet is face up (the
IBM text is dark) with the top of sheet to the right. The sheet travels from the printer input tray «1¬ to the
drum, which causes the sheet to be turned upside down «2¬. The drum prints the back side and the sheet
advances to position «3¬. The sheet is sent back through the printer «1A¬ where it is flipped over (top side
up (the IBM text is dark) «2A¬. The drum prints the front side of the sheet and the sheet advances to
position «3A¬ where it passes out of the printer (front side down (the IBM text is blocked) «F¬ into the
finisher.

When the sheet enters the finisher, it advances to a stop at position «4¬. At position «4¬, the back part of
the sheet is pulled between two rollers, causing a fold in the sheet. The sheet travels to position «5¬ where
the sheet is pulled between two rollers, causing the second fold. After the second fold, the sheet is placed

Figure 91. Simplex, Bin, and Finisher Z-Fold
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in the finisher’s output holding tray «6¬. The document can be stapled with other Z-folded sheets or other
sheets. The document is placed in the finisher’s output tray «7¬ when completed.

Finisher Input Tray

Sheets from the finisher insert tray can be pre-printed or blank sheets that the InfoPrint printer inserts
without additional printing. The sheets in the insert tray are inserted into documents according to the
application. Facing the finisher and looking down on the insert tray, the right side of the paper is the
leading edge. If the paper is pre-printed, it is face up and the edge to be stapled becomes the leading

Figure 92. Duplex, Bin, and Finisher Z-Fold
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edge. When the paper in the finisher insert tray is selected, the paper is turned upside down and the
leading edge is on the left to conform to the output from the printer. The finisher insert tray can be used
during any finishing operation (see Figure 93).

C
2P

I0
08

0

Finisher Input Tray

Staple Path
or

Sadle Stitch
Path

Figure 93. Finisher Paper Path
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